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1 – Introduction 
 
Welcome to SeisImager/SWTM!  SeisImager/SW is an easy-to-use, yet powerful program 
that allows you to analyze multi-channel active and passive source (microtremor) surface 
wave data.  SeisImager/SW includes functions to perform the following basic procedures, 
and more. 

 
• Input and display data. 
• Control how data is displayed. 
• Make changes/corrections to data files and save them. 
• Calculate and edit dispersion curves. 
• Invert data for a one-dimensional shear wave velocity curve. 
• Invert data for a two-dimensional shear wave velocity cross-section. 
• Display results in graphical form. 

 
SeisImagerTM is the master program that consists of four modules for surface wave and 
refraction data analysis.  The individual modules are PickwinTM, PlotrefaTM, WaveEqTM, 
and GeoPlotTM.  The Surface Wave Analysis WizardTM is not a separate module but 
automatically calls on specific functions from Pickwin, WaveEq, and GeoPlot to walk 
you through the analysis process. 
  

 
 
 
  
 
 
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 
 

 

 
1D curve 2D cross-section 2D cross-section 
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Pickwin and WaveEq are the main modules used for surface wave data analysis, making 
up the program called SeisImager/SWTM, which is available in two packages.  The first, 
SeisImager/SW-1D, is capable of one-dimensional (1D) analysis of multi-channel active 
and passive source (microtremor) data, with output of a single curve of shear wave 
velocity (Vs) viewed in WaveEq.  The second package, SeisImager/SW-2D, is capable of 
two-dimensional (2D) analysis of multi-channel active source data, with output of a 
cross-section of Vs viewed in GeoPlot.  Note that GeoPlot is its own standalone module 
for general data visualization.  In this manual, only the GeoPlot functions needed in the 
2D surface wave analysis process are covered.  GeoPlot will eventually be available as a 
separate module; at that time, a full manual will also be released.   
 
For refraction data analysis, Pickwin and Plotrefa make up the program called 
SeisImager/2DTM.  A separate manual exists for SeisImager/2D, and due to the overlap of 
Pickwin with SeisImager/SW, reference is made to the SeisImager/2D manual for 
explanation of the common Pickwin menus. 
 
SeisImager is also available for rent in run-time periods of 40, 75, and 250 hours.  The 
rental package by default includes both SeisImager/2D and SeisImager/SW-2D. 
 
Section 2 of this manual describes software installation, Section 3 describes data 
acquisition methods, Sections 4, 5, 6, and 7 describe data processing, and Section 8 
provides data examples.  Some theory is touched on, but this manual is not meant to be a 
treatise on multi-channel analysis of surface waves (MASW) or microtremor array 
measurements (MAM).  It is assumed that the user has a reasonable grasp of the main 
principals of seismology and mathematics in order to understand the principals behind the 
analysis techniques employed by the software.  See Section 9 for a recommended reading 
list on surface wave theory and techniques. 
 
Although the manual can be printed, it was designed as an online resource.  It will be 
updated on a semi-regular basis, and a current version will always be available by 
contacting us at seismicsales@geometrics.com or support@geometrics.com.  The manual 
makes liberal use of color, so if you elect to print it, using color is highly recommended. 
 
Finally, we are very interested in your constructive criticism of both this manual and the 
software itself.  Please contact us at seismicsales@geometrics.com with any comments 
you might have. 
 
Note: All screens in this manual were captured in Windows XP Home or Professional 
Edition.  If you are running a different version of Windows, some dialog boxes may look 
slightly different than they appear here. 
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2 – Installing the Software 
 
The SeisImager software CD is supplied (1) for trial evaluation of the programs, (2) for 
purchase, rental, or upgrade of one of the programs, or (3) with purchase of an ES-3000, 
SmartSeis ST, Geode, or StrataVisor NZ seismograph, which all include the Lite version 
of SeisImager/2D.  The single CD contains all programs and all documentation.  
Occasionally, there will be a software release in between CD releases.  In this situation, 
the CD will be labeled with a notice to refer to the SeisImager website to download the 
latest version. 
 
SeisImager is recommended for Windows XP Home or Professional but is compatible 
with all versions of Windows up to Vista.  Note that you must have Administrator rights 
to install the software.  After installation by an Administrator, users with lower level 
privileges can use the software.   
 
1.  To install the software, insert the SeisImager CD into the CD drive.  The contents of 
the CD will be listed as shown below.  
 

 
 
2.  Double-click on the file named SeisImager.msi to install the software.  The Welcome 
to the SeisImager Setup Wizard window will appear as follows. 
 

a. If you are presented with the option to Repair SeisImager or Remove 
SeisImager as shown below, the installer has detected an older version.  Select 
Remove SeisImager and click on Finish, then Close after the uninstall process 
is complete.  Double-click again on the file SeisImager.msi to install the new 
version as described in Step 2b. 
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b. If an older version is not detected, you will be presented with the installer as 

shown below.  Click on Next, indicate the directory for installation (the default 
directory is recommended), click on Next, Next, and Close.  It is not necessary to 
reboot the PC after completing the installation.   
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3.  To copy the SeisImager manuals to your hard drive (~125 MB), select the folders 
SeisImager2D_Manual and SeisImagerSW_Manual on the CD and copy them to your 
hard drive in the desired location.  Note that the SeisImager2D_Manual folder contains 
.avi video clips that must reside in the same location as the files 
SeisImager2D_Manual_vX.X.pdf and SeisImager2D_Examples_vX.X.pdf (where X.X is 
the current version).   
 
You will need Adobe’s freeware program Acrobat Reader to view the manual files.  If 
you need this program, go to the Adobe website to download the latest version 
compatible with your operating system.    
 
4. To register the software, go to the Start menu, under All Programs, SeisImager to 
find the SeisImager Registration  program as shown below.  If 
you are using the software on a trial basis in demonstration mode, skip to Step 5.  
Open the register and email the keyword shown to support@geometrics.com with your 
order number and seismograph serial number (if you purchased the software with a 
seismograph) and we will reply with a registration password to enable the version of the 
software you have purchased.  Once received, enter the password into the password field 
and click OK.   
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The programs enabled by the password will be reported in a series of messages.  For 
example, as shown below, for purchase of SeisImager/2D Standard and SeisImager/SW-
2D, the register reports that SeisImager/2D Standard, SeisImager/SW-2D, and GeoPlot 
Standard are registered.  Click OK to accept each message.  
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After these messages have appeared, the register will also reflect the programs that have 
been registered, as shown below.  
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Typically, installing an upgrade of the software does not require re-registration, but if you 
are upgrading from a version older than April 2007, you will need to re-register.   
 
5. Once installed, the program modules can be opened directly through the desktop 
icons shown below or through the links in the SeisImager Start menu folder.   
 

               
 

SeisImager/2D consists of the Pickwin and Plotrefa modules.  SeisImager/SW-1D 
consists of the Pickwin and WaveEq modules.  SeisImager/SW-2D consists of the 
Pickwin, WaveEq, and GeoPlot modules.  The Surface Wave Analysis Wizard is not a 
separate module but automatically calls on specific functions from Pickwin, WaveEq, 
and GeoPlot to walk you through the analysis process.  All of the icons will be shown 
regardless of which program(s) have been purchased or will be used.   
 
To begin using the software, double-click the Pickwin module icon.  If you have installed 
for the first time or upgraded from a version older than April 2007, a prompt will ask you 
to set the language as shown below.  Choose English.   
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For registered installations, upon selection of the language, the module opens and is 
ready for use.  As well, the other registered modules are ready for use.  For unregistered 
installations running in demonstration mode, proceed to Step 6. 
 
If the wizard icon is missing or when double-clicked does not open Pickwin, a new 
shortcut will need to be manually created.  In the software installation directory there is a 
file called Wizard_Readme.txt as shown below.     
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Open the file for instructions on how to create a new shortcut for the wizard. 
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6.  If you are using the software in demonstration mode, after selecting the language you 
will be presented with the registration dialog box as shown below.  Leave the password 
field empty and click OK.       
 

 
 
Detection of no password and the number of available run-times will be reported as 
shown below.  Click OK.  
 

 
 
After running the software in demonstration mode, if you later purchase the software, 
refer to Step 7 on how to enter your registration password.   
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7. To enter your password after running the software in demonstration mode, go to the 
Start menu, under All Programs, SeisImager to find the SeisImager Registration 

 program as shown below.  Open the register and email the 
keyword shown to support@geometrics.com with your order number and seismograph 
serial number (if you purchased the software with a seismograph) and we will reply with 
a registration password to enable the version of the software you have purchased.  Once 
received, enter the password into the password field and click OK.   
 

 
 
Once the software is registered (refer to Step 4 for a full description of the process), the 
data input dimensions of the demonstration version will be updated to reflect the limits of 
the program purchased.  Click OK.  
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This completes the description of all possible registration pathways.  
 
As mentioned previously, the Lite version of SeisImager/2D comes free with all 
seismograph purchases, so if you have purchased SeisImager/SW with a seismograph, 
you are also entitled to the Lite version of SeisImager/2D.  If you do not already have a 
license of SeisImager/2D, Lite or otherwise, but would like to order a copy, please 
contact us at seismicsales@geometrics.com or support@geometrics.com. 
 
A general recommendation when using SeisImager/SW is to close and reopen the 
software modules or open a second instance of the software modules to start new, 
separate analyses.  The programs are efficient and quickly launch so this is easy to do, 
and will prevent complications when data processing.   
 
If functions are selected in an illogical order for any given data processing flow, the 
program may crash and the standard Windows error message will appear.  With each 
release, more SeisImager messages are being incorporated to communicate to the user 
that the functions selected do not make sense and to allow for more elegant recoveries. 
 
Regarding making report graphics and documenting your data processing, it is handy to 
have a screen capture program such as HyperSnap from Hyperionics 
(www.hyperionics.com).  Bitmap screen captures can be quickly and easily made at the 
desired stages of processing and saved for import to Microsoft Office or other programs.  
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3 – Data Acquisition 
 
SeisImager/SW includes the functions for three main processing flows, two for analyzing 
active source datasets and a third for passive source datasets.  Methods for collecting 
these data types for input to SeisImager/SW are discussed in this section with specific 
set-up instructions using the ES-3000, SmartSeis ST, Geode, and StrataVisor NZ 
seismographs.  The basics of running the acquisition and data analysis software are 
covered, with a brief introduction to surface waves.  We recommend and refer you to the 
published body of literature for an in-depth discussion of surface wave theory and survey 
methods.   
 
Dispersion, or change in phase velocity with frequency, is the fundamental property 
utilized in surface wave methods.  Shear wave velocity (Vs) can be calculated by 
mathematical inversion of the dispersive phase velocity of surface waves.  Surface wave 
dispersion can be significant in the presence of velocity layering, which is common in the 
near-surface environment.  There are other types of surface waves, or waves that travel 
along a surface, but in this application we are concerned with the Rayleigh wave, which 
is also called “ground roll” since the Rayleigh wave is the dominant component of 
ground roll.  Although there are other types of surface waves, the term “surface wave” 
when used in the SASW (Spectral Analysis or Surface Waves), MASW (Multi-channel 
Analysis of Surface Waves), or MAM (Microtremor Array Measurement) context has 
come to mean the Rayleigh wave.  
 
There are two ways surface waves are generated.  “Active source” means that seismic 
energy is intentionally generated at a specific location relative to the geophone spread 
and recording begins when the source energy is imparted into the ground.  This is in 
contrast to “passive source” surveying, also called “microtremor surveying”, or 
sometimes referred to as “refraction microtremor” (or the commercial term “ReMi”) 
surveying, where there is no time break and motion from ambient energy generated by 
cultural noise, wind, wave motion, etc. at various, and usually unknown, locations 
relative to the geophone spread is recorded.   
 
Surface wave energy decays exponentially with depth beneath the surface.  Longer 
wavelength (that is, longer-period and lower-frequency) surface waves travel deeper and 
thus contain more information about deeper velocity structure.  Shorter wavelength (that 
is, shorter-period and higher-frequency) surface waves travel shallower and thus contain 
more information about shallower velocity structure.   
 
In this context, by their nature and proximity to the geophone spread, it can be said that 
higher frequency active source surface waves resolve the shallower velocity structure and 
lower frequency passive source surface waves resolve the deeper velocity structure.  
When the total depth of interest is great enough to require use of passive source surveys, 
it is still very important to sufficiently sample the shallower depths.  The shallower 
section will have a relatively large impact on average IBC Vs100 (UBC Vs30) curves and 
the usefulness of Vs cross-sections.  In SeisImager/SW the results from active and passive 
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source surveys can be combined to maximize the resolution and overall depth range of 
investigation.   
 

3.1 1D MASW Data Acquisition 
 
Seismic energy for active source surface wave surveys can be created various ways, but a 
sledgehammer to strike the ground is recommended since it is a low-cost, readily 
available item and tends to be energetic enough for most near-surface investigations.  Of 
course, a sledgehammer may not be appropriate for all situations and the actual source 
used should be tailored to the survey scale and goals.  To signal to the seismograph when 
the energy has been generated, a trigger switch is used as the interface between the 
hammer and the seismograph.  When the sledgehammer hits the ground, a signal is sent 
to the seismograph to tell it to start recording.   
 
Table 1 summarizes the parameters suggested for active source 1D MASW surveys.  
Most parameters are self-evident, but two settings to consider further, as they relate to the 
depth range of sampling, are the spread length and geophone interval.   
 
Surface waves sample to an approximate depth of their wavelength divided by two.  
Furthermore, in surface wave surveying it is assumed that the longest wavelength that can 
be sampled is as long as the spread length.  So, to determine the spread length, two times 
your depth of interest is a good (and the accepted) rule of thumb.  However, when 
combining active and passive source results, because the passive source survey can be 
used to sample greater depths, the active source survey spread length need not always be 
as long as two times the depth of interest.  To determine the active source survey spread 
length, it is suggested to consider the maximum distance that the source energy 
propagates and the shallowest depth of interest.  
 
For an active source survey with a sledgehammer, a geophone interval of 1.5 to 3 meters 
(5 to 10 feet) is suggested.  Using a 24-channel seismograph, this would give a spread 
length of 35 meters (115 feet) using the 1.5-meter (5-foot) geophone interval.  Applying 
the one-half-wavelength (or spread length) rule of thumb, the depth of sampling would be 
about 17.5 meters (58 feet).  Depending on the site materials and conditions, source 
energy may not strongly propagate to an offset of 35 meters (115 feet), and stacking may 
be needed and/or the geophone interval may need to be reduced.  You need to find a 
balance between signal propagation, geophone interval, and the spread length.  Site-
specific testing and judgment should always be applied to confirm that the suggested 
recording parameters are appropriate. 
 
If you were only doing an active source survey and would not have passive data to 
resolve greater depths, it is recommended that the spread length equal about two times 
the depth of interest.  Additionally, the active source survey can include two (or more) 
spreads, one with a shorter spread and lighter weight hammer and one with a longer 
spread and heavier weight hammer (or other source), to sufficiently sample a range of 
depths.  
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Table 1.  1D MASW Acquisition Parameters  
 
Parameter 
 

 
Setting 

 
Spread configuration 
 

 
Linear 

Spread length About equal to depth of interest when supplementing with 
passive source data; about equal to two times depth of 
interest if no passive source data available*  
 

Geophone interval 
 

1.5 to 3 m or 5 to 10 ft* 

Total number of 
geophones 
 

12 or more, minimum of 16 preferred 

Geophone type 4.5 Hz vertical geophones, with base plates for surveys on 
paved ground 
 

Shot locations 
 

Minimum of one shot, located in-line and off-end (either 
end) of spread; reverse shots suggested 
 

Shot near offset About 10 to 20% of spread length; an additional shot located 
at about 40% of spread length is suggested 
 

Source equipment Sledgehammer (most common), 8 lbs (3.6 kgs), 16 lbs (7.2 
kg), 20 lbs (9 kg), scale hammer weight up with increase in 
spread length*, and striker plate 
 

Trigger Hammer switch taped to sledgehammer handle and 
connected to seismograph trigger port 
 

Sample interval 0.5 milliseconds (ms) 
 

Record length 1 to 2 seconds (s), long enough to enclose the surface wave 
train 
 

Stacking 
 

As needed to improve data quality, wait for quiet times to 
shoot 
 

*also refer to preceding discussion in text 
 

3.1.1 1D MASW Survey Geometry 
 
The geometry of a survey describes the spatial relationship of the shot and receivers.  The 
spread of receivers will have some configuration and relative spacing to the shot(s).  
When there is one or just a few shots per survey, the geometry is fairly simple and easy to 
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track and record.  When the number of shots grows and especially if the spread locations 
change, like for a 2D MASW survey (Section 3.3), recording the geometry requires more 
attention and effort.   
 
3.1.1.1 1D MASW Survey Spread Configuration 
 
For 1D MASW surveying, a linear spread configuration is used (Figure 1).  The 
geophones are configured in a straight line on the ground and interconnected with a 
spread cable (black line).  The distance between the first and last active geophone is the 
spread length or total offset and the distance between the shot location and the nearest 
active geophone is the near offset.  The resultant Vs curve is an average over the spread 
and accordingly should be located at the center of the spread. 
 

 
 

 

Figure 1.  1D MASW survey spread configuration. 

 

3.1.2 1D MASW Survey Data Acquisition with Geometrics Seismodule 
Controller Software 

 
The data acquisition set-up is illustrated using the Geometrics Seismodule Controller 
Software (SCS) for the ES-3000, SmartSeis ST, Geode, and StrataVisor NZ 
seismographs.  Other seismographs that record data in the SEG-2 file format can also be 
used.  In this section, the essential software dialog boxes pertaining to acquisition of 
surface wave data are discussed, with the menu paths indicated in the PATH boxes.  The 
dialog boxes are addressed in order that they appear in the software, working from left to 
right on the menu bar.  You may also want to set parameters in other dialog boxes not 
mentioned in the section.  Please refer to the separate manual specific to your 
seismograph for a complete explanation of SCS.  The seismograph manuals should also 
be referred to for instructions on how to set up the system hardware.  
 
The first step is to install SCS.  Once this is done, launch SCS from the icon on your 
desktop, or from the Start menu under All Programs, Geometrics, Seismodule Controller.  
 

  
 

Shot point Spread length  

Geophone 

Near offset
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If this is the first installation of SCS on your PC, you will be presented with a 12-digit 
code and asked for a registration password.  Copy and paste the 12-digit code in an email 
and send with the serial number of your seismograph to support@geometrics.com.  You 
will be sent a 40-digit registration password.  Email is recommended because it is easy to 
mistype or misspeak the code and registration password.  
 
3.1.2.1 1D MASW Survey SCS Set-up 
 
First, assign a Survey Name and Initial Line Number.  The Survey Name is used as the 
name for the survey log that is maintained during the survey.  All software activities 
during the survey, such as parameters set or files written to the hard drive, are saved to 
the survey log.  The survey log is a text file that you can recall at a later time for 
reference.  Click OK when done.  
 

 
 
Next, set the Geophone Interval, or distance between each geophone in the line, and the 
applicable units.  Click OK when done. 
 

 
 
Next, set up the survey geometry.  In the Geometry dialog box, it is recommended to 
navigate using the keyboard keys, not the mouse.  The up and down arrow keys will 

PATH: Access 
dialog box through 
the Survey menu.  

PATH: Access 
dialog box through 
the Geom > 
Geophone Interval 
menu.  
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move the cursor between rows and the right and left arrow keys will move the cursor 
between columns.  Note that the Backspace key functions the same as the left arrow key.   
 
Below the graphical display of the spread, the parameters are viewed as rows and 
columns.  The row names are shown on the left hand side and the column names are the 
Trace numbers shown just below the spread graphic.  The cells for Interval are offset to 
indicate that the entered value is the distance between Trace 1 and 2, 2 and 3, etc.     
 

 
 
The Geophone Interval entered in the previous dialog box is shown.  The default Shot 
Coordinate and starting Geophone Coordinate is zero, but whatever numerical coordinate 
system you wish may be used.  If a value is changed, the change will ripple through the 
rest of the coordinates if Ripple is checked (the default).   
 
Note that the seismograph is wired so it is always on the “high-side”.  That is, in native 
configuration, the nearest channel or geophone to the seismograph is always the highest 
channel number.  For example, with a 24-channel Geode seismograph connected to a 24-
takeout spread cable, when the line is set up, the nearest geophone to the Geode will be 
24.  Further on this point, if you want the source location to be off the end nearest the 
seismograph, the Shot Coordinate value will need to be changed from 0 to the 
appropriate value greater than the coordinate of geophone 24.  Once it is determined 
which end of the spread the shot is located, set the Shot Coordinate to reflect that 
location.   
 

PATH: Access 
dialog box through 
the Geom > 
Group/Shot 
Locations menu.  
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If the data is recorded with the wrong geometry, it can easily be assigned in 
SeisImager/SW at the time of data processing.  
 
The default settings in the rows Gain (how much the signal is boosted before digitization) 
and Use (how a channel is used), require no adjustment.  If your settings do not match the 
default settings shown, go ahead and change them.  For all channels, the Use row should 
be Data.  Gain is changed in a subsequent menu.  Click OK when done. 
 
Next, set the Sample Interval and Record Length.  Click OK when done.  
 

 
 
Next, check the acquisition filter settings.  Acquisition filters are destructive, any data 
filtered with an “acquisition” (versus “display”) filter will be irretrievably removed.  
Acquisition filters are not typically needed when collecting surface wave data, and thus, 
should be disabled with the setting Filter Out.  Click OK when done. 
 

 
 
Next, set the stack options.  Stacking is a way to increase the signal-to-noise ratio by 
hitting the striker plate repeatedly at each shot point and adding the files together as they 

PATH: Access dialog 
box through the 
Acquisition > Sample 
Interval/Record Length 
menu. 

PATH: Access dialog 
box through the 
Acquisition > Acquisition 
Filters menu.  
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are collected.  Coherent signal will add in and incoherent noise will cancel out.  In many 
cases, stacking will not be needed, and thus, the Stack Limit default value is set to 1.  If, 
for example, you are in an urban environment and there is a high level of noise or the 
signal quality on the distant traces is low, stacking will help.  (Remember that what is 
called “noise” in an active source survey is the signal recorded during a passive source 
survey.)  The benefits of stacking start tapering off after ~8 stacks.  To stack 8 times, 
enter 8 as the Stack Limit.  Click OK when done. 
 

 
 

PATH: Access 
dialog box through 
the Acquisition > 
Stack Options menu. 
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Next, set the gains to All High Gain, which equals 36 dB.  All Low Gain equals 24 dB 
and Individual applies when non-uniform gain settings are applied.  There may be cases 
where the geophones nearest the shot location are close enough that they are overdriven 
by the signal and the recorded waveform is clipped.  In this situation, Individual gain 
settings of 24 dB for the near channels and 36 dB for the rest of the channels can be used. 
Click OK when done.  
 

 
 
 

PATH: Access dialog 
box through the 
Acquisition > Preamp 
Gains menu.  
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Next, set up how the data files will be saved.  The Next File Number should be a 
numerical value; after each save, the name will automatically increment by one.  For the 
SEG-2 format, the file extension .dat is appended to the numerical name.  Since the 
survey line is called Line 1, the suggested starting file number is 101.   
 
Auto Save checked means that each file will be automatically saved after the Stack Limit 
is reached.  If this is unchecked, you will need to manually save (and clear) each file.  
The Stack Limit reflects what was entered in the previous Acquisition Stack Parameters 
dialog box.  
 
For the Path of saved data, note that only one folder deep can be created.  Enter the 
desired folder name.  Click OK when done. 
 

  
 
This is the last essential dialog box in SCS for the 1D MASW survey set-up.     
 

PATH: Access 
dialog box through 
the File > Storage 
Parameters menu.  
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3.1.2.2 After Set-up – Acquiring, Displaying, and Quality Checking 1D MASW Data 
 
Once the set-up is complete, you are ready to begin data collection.  An example of the 
main SCS window is shown below.  The number of traces in the Noise Monitor Window 
matches the number of channels in the seismograph, this example shows 24 traces.  
 

 
 
Before any data is recorded, use the Noise Monitor Window to check the line.  Tap the 
top of the nearest geophone and watch which trace shows a response; it should be the 
geophone with the highest channel number.  Check that the response level of all the 
geophones is about the same.  If there is a trace with a dissimilar or atypical level of 
noise, walk down the line to check that the internal sensor element is able to oscillate 
freely (give a gentle shake up and down in the vertical orientation).  Make sure the 
geophone is correctly and vertically planted and that it is connected to the spread cable.  
It is best practice to make sure all traces are responding properly before collecting data.   
 
Next check that the status bar on the bottom of the window shows an Armed condition 
colored green.  You may want to first press the 1 shortcut key to toggle the armed state 
off and practice swinging the hammer and hitting the striker plate.   
 
When ready, return the system to an Armed state, and swing the hammer at the shot 
location.  Check to confirm that the system triggered and the shot was recorded.  A 
typical active dataset consists of one (or more as needed) shot records.   
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When you first view the data, probably the display gains will need adjustment.  One 
condition that can occur is that the signal may not be visible for all traces as shown in the 
record below.   
 

  
 
To adjust the display gains, select Auto Scale Traces or press the 6 shortcut key.  By 
selecting Auto Scale Traces, the software finds the gain that optimizes the allotted space 
for each trace in the Shot Window.  
 

 

PATH: Access 
dialog box through 
the DoSurvey > 
Auto Scale Traces 
menu.  
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To further adjust the gain, highlight the Shot Window and use the right arrow key to 
activate the display gain controls.  If when you press the right arrow key, the Shot 
Display Gain Style Parameters dialog box appears, choose Fixed Gain.  Click OK when 
done.   
 

 
 
Press the right arrow key again and, as directed in the instruction box, use the up and 
down arrow keys to increase and decrease the gain by the same amount for all channels.   
 

 
 
Press the Esc key to end.   
 
The Shot Window can also be zoomed in and out using the Page Down and Page Up keys 
and scrolled up and down using the up and down arrow keys.  
 

PATH: Access 
dialog box through 
the Display > Shot 
Parameters > 
Gain Style menu.  

PATH: Access 
dialog box through 
the right arrow key 
when the Shot 
Window is selected.  
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The final display settings should provide a shot record looking similar to that shown 
below.   
 

    
 
Once the display parameters are optimized, check for the presence of dispersive surface 
waves.  Surface waves are relatively lower frequency, higher amplitude, and slower than 
other events in the record.  Ground roll in a “wedge” or “fan” shape indicates dispersion.  
In addition to visual analysis, refer to Section 4 on how to run a field check of dispersion 
using SeisImager/SW. 
 
After you have collected the active source record(s) and are satisfied with the data, 
continue to the passive source survey if applicable. 
 

Ground roll 
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3.2 MAM Data Acquisition  
 
During a passive source survey the seismograph records ambient vibrations generated by 
cultural noise, traffic, factories, wind, wave motion, etc.  There is no timing device to 
trigger the seismograph.   
 
The ideal vibration sources are steady, at a constant level.  The fundamental assumption 
of microtremor data analysis using the spatial autocorrelation (SPAC) method of 
SeisImager/SW is that the signal wavefront is planar, stable, and isotropic (coming from 
all directions) making it independent of source locations.  A high level of intermittent 
noise (like nearby passing cars) is tolerable if the sources are relatively distant 
(approximately equal to or greater than one array length).  Even if the intermittent noise 
sources are near, this is usually countered by recording long records (32 seconds) and at 
least 20 records.  Long records make for smooth input when the records are converted 
from the time to frequency domain and many records provide a statistically robust 
representation of ambient vibrations.  Table 2 summarizes the recommended passive 
source acquisition parameters.   
 

 

Table 2.  MAM Acquisition Parameters 
 
Parameter 
 

 
Setting 

 
Spread/array configuration 
 

 
L-shape, Triangle, Circle, Linear, or custom 

Array size Minimum of 1 times depth of interest 
 

Geophone interval 
 

Up to 15 m or 45 ft, adjust to suit array configuration and 
size 
 

Total number of 
geophones 
 

Various based on spread configuration 

Geophone type 4.5 Hz vertical geophones, with base plates for surveys on 
paved ground; alternatively, if available, 1 or 2 Hz 
seismometers can be used, especially if depth of interest is 
greater than 30 m (100 ft) 
 

Trigger 
 

Manual keyboard trigger 

Sample interval 2 milliseconds (ms) 
 

Record length 32 seconds (s) each record, total of at least 20 records 
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3.2.1 MAM Survey Geometry 
 
3.2.1.1 MAM Survey Spread Configurations 
 
SeisImager/SW allows four set types of passive source spread or array configurations and 
a custom option.  Figures 2 through 6 illustrate the various set configurations.  As in 
Figure 1, the black line represents the spread cable and the green inverted triangles 
represent the geophones.   
 
Of the four set arrays, one is linear and three are 2D, that is, geophones are distributed in 
two directions versus a line, on the ground surface.  2D arrays provide the most rigorous 
distribution of data points for analysis; however the SPAC method used by 
SeisImager/SW handles data from all array types because it is independent of source 
location.  Consider a linear array – if microtremors propagate parallel to the survey line, 
the surface wave phase velocity can be directly calculated.  Conversely, if microtremors 
propagate perpendicular to the survey line and reach all of the geophones at the same 
time, the phase velocity cannot be calculated.  As the angle of propagation increases from 
parallel to perpendicular, the apparent phase velocity increases.  In reality, sources of 
microtremors vary and energy radiates from many directions at unknown angles to the 
geophones.  Since angles of propagation are unknown, with a linear array, the calculated 
phase velocity may be higher than the actual phase velocity unless a method independent 
of the source locations such as SPAC is applied.      
 

 
Figure 2.  Map view of MAM survey equilateral triangle spread configuration with 10 geophones (Triangle 
10).  

  
 

Array size
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Figure 3.  Map view of MAM survey equilateral triangle spread configurations with 7 (Triangle 7) and 4 
geophones (Triangle 4). 

 
For a triangle array (Figures 2 and 3), the Array size is equal to the side length.  The 
resultant Vs curve is an average over the array and accordingly should be located at the 
center of the triangle.  
 
 

   
Figure 4.  Map view of MAM survey L-shape spread configurations with 11 (L11), 9 (L9), and 7 (L7) 
geophones.  

 
For an L-shape array (Figure 4), the Angle between the branches of the L is typically 60 
to 90 degrees, but technically can be as small as 0 degrees, which is a linear array.  Both 
branches are the same length; the Array size equals the length of the branches.  The  
resultant Vs curve is an average over the array and accordingly should be located 
essentially at the origin or near the origin between the two branches of the L.  The L-
shape array is the two-dimensional array that is easiest to set up in the field.  It can easily 
be constructed after an active source survey by turning one-half of the spread 90 degrees 
and adjusting the geophone intervals to span the required Array size.   
 
 

Array size 90 degrees 
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Figure 5.  Map view of MAM survey circle spread configurations with 8 outer geophones on one circle and 
one center geophone (Single circle 9) and 18 geophones in two circles and one center geophone (Double 
circle 37).   

 
For the Double circle 37 array (Figure 5), the inner circle diameter equals one-half the 
outer circle radius.  For all circle arrays, the Array size equals the diameter of the outer 
circle.  The resultant Vs curve is an average over the array and accordingly should be 
located at the center of the circle.   
 
 
 
 

   
 
 

 

Figure 6.  MAM survey linear spread configuration using all channels, one per geophone.   

      
For a linear array (Figure 6), the Receiver spacing equals the geophone interval and the 
Number of receivers equals the number of geophones.  The resultant Vs curve is an 
average over the array and accordingly should be located at the center of the spread.   
 

3.2.2 MAM Survey Data Acquisition with Geometrics Seismodule 
Controller Software 

 
The data acquisition set-up for MAM surveys involves the same dialog boxes used in the 
1D MASW survey set-up.  This section assumes that you have already worked through 
the 1D MASW survey set-up, that you are doing a MAM survey at the same site to 
supplement the 1D MASW survey, and that the MAM survey type is L11 for a depth of 
interest of approximately 30 meters (100 feet).  MAM surveys can also be performed to 

Receiver spacing (geophone interval) 

1 16

Array size

Number of receivers (geophones) 
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supplement 2D MASW.  Refer to Section 3.1.2 for an introduction to the 1D MASW set-
up process and for more detail on the dialog boxes common to both survey set-ups.   
 
3.2.2.1 MAM Survey SCS Set-up 
 
First, assign a Survey Name and Initial Line Number.  An Initial Line Number of 2 
indicates that this is a new line configuration with different geophone locations compared 
to Line 1.  
 

 
 
Next, set the Geophone Interval to reflect the distance between active geophones in the 
applicable units.  Although it is common practice to set the geophone interval and units at 
the time of acquisition, this is not essential for MAM surveys because the full geometry 
(configuration and Array size) will be set in SeisImager/SW at the time of data 
processing.   
 

 
 
 

PATH: Access 
dialog box through 
the Survey menu.  

PATH: Access 
dialog box through 
the Geom > 
Geophone Interval 
menu.  
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 Next, set up the survey geometry.   
 

 
 
Since there is no active source at a single location, the Shot Coordinate is non-applicable 
and should equal zero.   
 
For most of the MAM array configurations that are 2D (L-shape, Triangle, Circle) you 
will likely be recording on fewer channels than the total number of channels in the 
seismograph.  The unused channels should be deactivated.  Deleting of dead channels can 
be done in SeisImager/SW, but it is most efficient to deactivate them at the time of 
acquisition.  Uncheck the Ripple box and in the row named Use, use the 4 key and the 
right arrow key to individually deactivate the channels that have no geophone connected 
to that takeout.   
 
Example 3A For a 16-channel seismograph with 30-foot interval spread cable, in an 

L11 array with geophones 30-feet apart, the channels on the end of the 
spread that are not connected to geophones are deactivated.  This equals 
channels 1 through 5 if channel 11 is positioned at the corner of the L, or 
channels 12 through 16 if channel 6 is positioned at the corner of the L.  
End Example 3A. 

 
Example 3B For a 24-channel seismograph with 5-meter interval spread cable, in an 

L11 array with geophones 10-meters apart, with channel 12 positioned at 

PATH: Access 
dialog box through 
the Geom > 
Group/Shot 
Locations menu or 
press the 3 
shortcut key.  
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the corner of the L, channels 1, 3, 5, 7, 9, 11, 13, 15, 17, 19, 21, 23, and 24 
are deactivated.     

 

 
End Example 3B. 
 
The Geometry dialog box only shows linear configurations of geophones, you will not 
see a graphic of the actual 2D L-shaped array.  This is fine; as mentioned previously, the 
full geometry is set in SeisImager/SW at the time of data processing.  The main setting 
here is deactivation of unused channels.   
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Next, set the Sample Interval and Record Length.    
 

 
 
Next, make sure the acquisition filters are disabled.   
 

 
 
 

PATH: Access dialog 
box through the 
Acquisition > Sample 
Interval/Record Length 
menu.

PATH: Access dialog 
box through the 
Acquisition > Acquisition 
Filters menu.  
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Next, set the Stack Limit to 1 since stacking is non-applicable to MAM surveys.   
 

 
 
Next, make sure the gains are set to All High Gain.   
 

PATH: Access 
dialog box through 
the Acquisition > 
Stack Options menu. 

PATH: Access dialog 
box through the 
Acquisition > Preamp 
Gains menu. 
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Next, set the Next File Number.  Since the survey line is called Line 2, set the Next File 
Number to 201.  Leave Auto Save on and the Stack Limit set at 1.  For the Path of saved 
data, enter the desired folder name.     
 

 
 
This is the last essential dialog box in SCS for the MAM survey set-up.     
 
3.2.2.2 After Set-up – Acquiring, Displaying, and Quality Checking MAM Data 
 
Once the set-up is complete, you are ready to begin data collection.  An example of the 
main SCS window is shown below.  As discussed for 1D MASW surveys, perform the 
same system checks before starting acquisition.  Check that the status bar on the bottom 
of the window shows an Armed condition colored green.   
 
 
 

PATH: Access 
dialog box through 
the File > Storage 
Parameters menu.  
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Once ready, manually trigger, by pressing the t shortcut key or select the System menu, 
Manual Trigger.   
 

 
 
After triggering, wait for the record to be acquired and saved.  Repeat at least 19 more 
times.  Refer to the status bar to monitor the stage of acquisition.  With a record length of 
32 seconds, times 20 records, equals 640 seconds or about 10 minutes total.    

PATH: Access 
function through the 
System menu, Manual 
Trigger or press the t 
shortcut key.  
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A typical passive source record is shown below.  You may need to adjust the display 
gains with Auto Scale Traces (6 shortcut key).   
 

   
 
There will likely be some coherent noise events representing when cars have passed or 
such.  Some isolated variation in amplitude usually does not significantly impact data 
quality.  A steady signal of noise without strong changes in amplitude throughout the 
record and from trace-to-trace is ideal.   
 
In addition to visual analysis, refer to Sections 4 and 5 on how to run more sophisticated 
checks of data quality.  
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3.3 2D MASW Data Acquisition 
 
As with 1D MASW surveying, 2D MASW surveys use an active source with a linear 
spread of geophones.  Instead of one shot however, numerous shots are taken at 
incrementing locations, and the geophone spread may not be fixed depending on the total 
survey line length.  (Remember here that 1D and 2D refer to the type of results, that is, Vs 
curve or cross-section, respectively, not to the spread configuration.)  Acquisition of 
numerous shot records allows SeisImager/SW to calculate a Vs cross-section. 
 
Table 3 summarizes the parameters used for active source 2D MASW surveys.  The 
discussion on selecting geophone interval and spread length from Section 3.1 applies.  
Passive source data may not be available, or if available, will only supplement with a 1D 
Vs curve, so the active source energy level will have larger bearing on the maximum 
possible depth of penetration.   
 

Table 3.  2D MASW Acquisition Parameters  
 
Parameter 
 

 
Setting 

 
Spread configuration 
 

 
Linear 

Spread length About equal to two times depth of interest assuming that no 
passive data is available; about equal to depth of interest 
when supplementing with passive source data 
 

Total number of 
geophones 
 

12 or more, minimum of 16 preferred 

Geophone interval 
 

1.5 to 5 m or 5 to 20 ft, adjust according to number of 
channels available and to suit required spread length  
 

Geophone type 4.5 Hz vertical geophones, with base plates for surveys on 
paved ground; optionally configured in a land streamer for a 
towed spread 
 

Shot locations 
 

Depending on spread configuration, multiple in-line 
locations at appropriate offset and interval  
 

Shot near offset  About 10 to 20% of spread length (applies to configurations 
where this parameter does not equal one-half the geophone 
interval, such as the roll-along end-on spread) 
 

Source equipment Sledgehammer (most common), 8 lbs (3.6 kgs), 16 lbs (7.2 
kg), 20 lbs (9 kg), scale hammer weight up with increase in 
spread length, and striker plate 
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Table 3.  2D MASW Acquisition Parameters  
 
Parameter 
 

 
Setting 

Trigger Hammer switch taped to sledgehammer handle and 
connected to seismograph trigger port 
 

Sample interval 0.5 milliseconds (ms) 
 

Record length 1 to 2 seconds (s), long enough to enclose the surface wave 
train 
 

Stacking 
 

As needed to improve data quality, wait for quiet times to 
shoot 
 

 

3.3.1 2D MASW Survey Geometry 
 
The basic linear geometry of MASW surveys is described in Section 3.1.1.  The linear 
spread is simple, but with addition of numerous shots and possibly an incrementing 
geophone spread, the geometry of 2D MASW surveys is more involved.  To illustrate the 
2D MASW geometries, the following sections use more sophisticated plots generated by 
Pickwin.  The figures are based on 24-channel examples.  Table 4 explains the symbols 
used in the Pickwin geometry plots shown in this section.  
 

Table 4.  Selected 2D MASW Geometry Plot Attributes  
 
Circle/Dot Color 

 
Meaning 
 

 
Teal blue  

 
Shot point 
 

Yellow  Receiver for which a trace (waveform) has been read  
 

Black  Grid point (no meaning in actual geometry) 
 

 
The geometries used in 2D MASW surveying, especially the roll-along end-on spread 
configuration, may look familiar as they are adopted from reflection seismology.  
SeisImager/SW also utilizes the reflection concept of the mid-point, which is the point 
midway between a source-receiver pair, and the common mid-point (CMP) gather, which 
is an assembly of traces that have the same mid-point.  For any given spread 
configuration, SeisImager/SW cross-correlates every pair of traces in a shot record, 
gathers all correlation traces by CMP, then those traces having equal spacing are stacked 
in the time domain (Hayashi and Suzuki, 2004).  These additional steps advance the 
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original MASW technique by effectively increasing the lateral resolution and accuracy of 
the final Vs cross-section.  
 
In Figure 7, the top row (1) illustrates the distribution of CMPs for a shot record (1b) and 
a CMP gather (1c).  Gathering by CMP (1c) focuses sampling and thus, increases the 
signal-to-noise ratio and lateral resolution.  The bottom row (2) illustrates how the CMP 
concept is applied to surface wave methods.  Analysis by shot record (2b) for 1D MASW 
poses no resolution issues as 1D MASW provides a single Vs curve averaged over the 
total length of the spread.  A series of 1D MASW Vs curves could be used to construct a 
Vs cross-section, but first processing by CMP (2c) increases lateral resolution and 
accuracy.  
 

  
Single channel record 

 
Shot record 

 
CMP gather 

 
 
1. Distribution of 
sampling for 
reflection methods 

 

 
 
1a. 

 

 
 
1b. 

 

 
 
1c. 

  
Original surface wave 

method (SASW) 
 

 
New surface wave 
method (MASW) 

 
Advanced surface 

wave method (CMP-
based MASW) 

 
 
2. Distribution of 
sampling for active 
source surface wave 
methods 

 

2a. 

 

2b. 

 

2c. 
 

Figure 7.  The CMP concept applied to 2D MASW. 

 
Another issue, not necessarily a benefit but rather something to be aware of and account 
for if needed, is that the multiplicity of CMPs (the fold) tapers down toward the ends of 
the survey line.  Note that the higher the fold, the higher the signal-to-noise ratio.  The 
effect is that the lateral sampling decreases from the mid-point(s) of maximum fold to the 
ends of the survey line.  Methods to account for this in survey design are discussed 
below.  
 
3.3.1.1 Fixed Receiver Spread Configuration 
 
The simplest configuration for 2D MASW surveys is the fixed receiver spread (Figure 8).  
The geophones are set up in a line at fixed locations and the shot is moved through the 
spread.  The first shot is located off-end at a near offset of one-half the geophone interval.  
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The shot is then advanced at an increment equal to the geophone interval so subsequent 
shots are located midway between geophones.  As the Shot number increases, the shot 
location advances by one interval across the Survey distance.     
 
 

 
 
 

Figure 8.  2D MASW fixed receiver spread configuration. 

 
The last shot is located off the opposite end by the same near offset of one-half the 
geophone interval.   
 
The Spread length (a) equals the survey line length over which there are active 
geophones.  The survey depth is approximately a/4 to a/2. 
 
The fixed receiver spread is useful if the survey line length of interest is not very long, if 
the survey area is confined, or there are limited channels and time/labor resources 
available. 
 
With a shot interval equal to the geophone interval, the fold will be highest at the center 
shot; that is, in between the two middle geophones, and will taper down on either side.  
The effect of tapering is to reduce the accuracy of analysis at depth.  If full fold is desired 
for the entire survey line of interest, the continuous fixed receiver spread or the roll-
along end-on spread should be used.   
 

Survey distance 

Shot 
number 

Spread length (a) 

Geophones physically 
located on one line only.  
Rows at greater shot 
numbers shown to 
illustrate progression of 
shot location.  

Up-line  
direction 
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3.3.1.2 Continuous Fixed Receiver Spread Configuration 
 
In many cases, one fixed receiver spread is not sufficient to cover the survey line length 
of interest.  So the fixed receiver spread can be used continuously, by taking a set of 
shots, moving the past receivers up-line, then resuming with another set of shots (Figure 
9).  First, Spread A is set up then 12 shots (one end-shot and 11 inner-spread shots) are 
taken.  Receivers from sub-spread A1 are advanced up-line to become sub-spread B1.  
Shooting resumes for 12 more (inner-spread) shots, then sub-spread A2 is advanced up-
line to form sub-spread B2.  There will be 24 channels live for each shot.  This process 
continues until the survey line length of interest has been covered.   
 

 
Figure 9.  2D MASW continuous fixed receiver geometry. 

 
The Spread length (a) equals the survey line length over which there are active 
geophones.  The survey depth is approximately a/2. 
 
The fold will be at full value when the number of shots from the start of the line equals 
half the number of active geophones per shot; full fold starts tapering down when the 
number of shots remaining to the end of the line equals half the number of active 

Survey distance 

Shot 
number 

Spread length (a) 

A1 A2 B1 

Spread A Spread B 

.  .  .  

Up-line  
direction 
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geophones per shot (again assuming that the shot interval equals the geophone interval).  
For the example in Figure 9, full fold will start at shot 13 in between geophones 12 and 
13 (between sub-spreads A1 and A2).  It is best practice to leave space at the survey site 
so the locations of full fold can be positioned at the start and end of the survey line of 
interest.  The fold tapering over 12 geophone intervals of 2 m equals 24 m; where the 
survey line of interest equals x, then the total survey line equals 24 m + x + 24 m.   
 
This method of acquisition requires spread cables with a number of takeouts equal to one-
half the seismograph channels.  This allows for the first spread cable and associated 
geophones to be picked up and advanced at the halfway point.  For the example in Figure 
9, with a 24-channel seismograph, you would need two 12-takeout cables.  Furthermore, 
having a third spread cable and set of geophones would allow you to set-up sub-spread 
B1 in advance and minimize downtime in between each set of shots.  
 
The continuous fixed receiver spread becomes tedious if your survey line is very long.  
An advancement on this method with increased efficiency is the roll-along end-on spread 
configuration.      
 
3.3.1.3 Roll-along End-on Spread Configuration 
 
For long survey lines, the spread needs to be efficiently advanced by a more automated 
means compared to the continuous fixed receiver spread.  There are three methods to 
achieve this using the roll-along end-on spread configuration.   
 

A. Software roll-along: most modern seismographs are capable of rolling an active 
spread of channels via software.  The seismograph will require more channels 
than the actual number of live channels per shot, typically 50% to 100% more.  
For example, if 24 channels is the desired number of live channels, a 48-channel 
seismograph with 48 geophones is set up.  Using software roll-along, the 24 live 
channels are rolled through the total of 48.  For the first shot, channels 1-24 are 
active, for the second shot, channels 2-25 are active, etc.  After the last shot with 
channels 25-48 active, the first half of the spread is picked up and moved up-line 
similarly to the continuous fixed receiver spread.  Note that software roll-along is 
not only for rolling an active spread, it is also used with the other methods to roll 
geometry coordinates.   

 
B. Land streamer: geophones are affixed to a “streamer” that makes gravity contact 

with the ground and is towed, typically by hand or an ATV or other vehicle.  The 
streamer connects to a seismograph positioned on the vehicle, the number of 
geophones equals the number of recording channels, and all channels are kept 
active for each shot.  The source is usually located in between the vehicle and the 
streamer or on the down-line end of the streamer, and its location is incremented 
together with the streamer after each shot.   

 
C. Mechanical roll box (also called roll-along switch): a separate box is connected 

between the spread cables and seismograph, interfaced with a set of input/output 
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cables.  The number of spread cable takeouts is larger than the number of 
seismograph channels, usually by 100%.  The roll box allows the seismograph 
channels to be advanced up-line by mechanical rotation of the connections 
between the channels and takeouts.  For example, spread cables with a total of 48 
takeouts are connected to a roll box with input of 48 channels and output of 24 
channels, which are transmitted to a 24-channel seismograph.  For the first shot, 
channels 1-24 are connected to takeouts 1-24 and takeouts 25-48 are 
disconnected.  After the first shot, the channel connections are advanced by 
turning a dial on the roll box which disconnects takeout 1 and connects channel 
25.  The source location is incremented together with the active spread.     

 
For all scenarios, the shot will usually have some near offset equal to about 10% to 20% 
of the survey line length.  Figure 10 illustrates the roll-along end-on spread configuration 
with a fixed receiver spread configuration used at the end of the line.   
 
 

 
Figure 10.  2D MASW roll-along end-on geometry. 

 

Survey distance 

Shot 
number 

Spread length (a) 
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direction 
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The Spread length (a) equals the survey line length over which there are active 
geophones.  The survey depth is approximately a/2.  The fold value is determined the 
same as for the other spread configurations.  
 

3.3.2 2D MASW Survey Data Acquisition with Geometrics Seismodule 
Controller Software 

 
The data acquisition set-up for 2D MASW surveys involves the same dialog boxes used 
in the 1D MASW survey set-up plus a few more for advanced geometry settings.  This 
section assumes that you have already worked through the 1D MASW survey set-up and 
only covers the dialog boxes that are new for 2D MASW surveying.  Refer to Section 
3.1.2 for an introduction to the 1D MASW set-up process and for more detail on the 
dialog boxes common to both survey set-ups.   
 
3.3.2.1 2D MASW Survey SCS Set-up 
 
The difference between the 1D and 2D MASW survey set-ups is the geometry.  As 
mentioned previously, 2D MASW surveying involves numerous shots at incrementing 
locations, and the geophone spread may or may not be fixed.  The geometry can be 
automatically updated and recorded to the file headers during acquisition or it can be 
tracked and recorded separately by hand in observer’s notes and assigned in 
SeisImager/SW at the time of data processing.  It is also possible to manually update the 
geometry in software after each shot but this is not recommended as it usually slows 
production down.  
 
SCS can be set up to automatically increment just the shot coordinate or both the shot and 
receiver coordinates depending on the type of spread configuration used and if the SCS 
roll-along function is available.  If you have the SCS roll-along function and choose to 
record the geometry in the file headers during acquisition, continue with this section to 
set up SCS.  If you do not have the SCS roll-along function and/or choose to assign the 
geometry in SeisImager/SW at the time of data processing, skip this section.  
 
Once Section 3.1.2.1 has been completed, the shot and receiver coordinates can be set up 
to automatically increment depending on the configuration, either a fixed receiver spread, 
continuous fixed receiver spread, or roll-along end-on spread.   
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For a fixed receiver spread configuration, the shot coordinate is set to automatically 
advance after each shot.  First, check that the starting shot location is set off from the 
spread by one-half the geophone interval using the Geometry dialog box.   
 

 
 

PATH: Access 
dialog box through 
the Geom > 
Group/Shot 
Locations menu or 
press the 3 
shortcut key.  
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Example 3C For a fixed receiver spread, with a geophone interval of 10 feet and first 
geophone coordinate of 100 feet, the first shot is set at 95 feet.     

 

 
End Example 3C. 
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Next, set up rolling of the shot coordinate in the Roll Parameters dialog box.  The Shot 
Roll Increment should equal 1 to advance the shot by one Geophone Interval after the 
previous file is saved.  With a starting shot coordinate that is off-end by one-half the 
geophone interval, a Shot Roll Increment of 1 will position the rest of the shots midway 
between the geophones.  Check Enable Auto Roll Up/Right to advance the shot to the 
“right” or up-line.  If your shot was on the right of the geophone spread, you would roll 
“left” or down-line.  Click OK when done.  
 

 
 
When the Shot Roll Increment is not equal to the Active Spread Roll Increment a warning 
appears.  Since the receiver spread is fixed in this case and should not roll with the shot, 
ignore the warning and click OK.   
 

 
 

PATH: Access 
dialog box through 
the Geom > Roll 
Parameters menu.  
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Next, activate Auto Save as required with automatic rolling.   
 

 
 

PATH: Access 
dialog box through 
the File > Storage 
Parameters menu.  
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For the continuous fixed receiver spread configuration, the shot coordinate will be set to 
automatically advance after each shot in the same way as for the fixed receiver spread.  In 
addition, after the first half of the geophones are advanced up-line, the coordinates for the 
new locations occupied by geophones will need to be assigned through the Geometry 
dialog box.  
 
Example 3D For a continuous fixed receiver spread, with a geophone interval of 10 feet 

and first geophone coordinate of 100 feet, the starting shot coordinate is 
set to 95 feet.  The geophone coordinates are set to 100 feet for geophone 
1, 210 feet for geophone 12, and 330 feet for geophone 24.   
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After the first half of the geophones are advanced up-line, the continuing coordinates are 
set to 220 to 450 feet and the next starting shot coordinate to 215 feet. 
 

 
End Example 3D. 
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For a roll-along end-on spread configuration, the geometry set-up will depend on the 
rolling method (Section 3.3.1.3), using either software roll-along (Method A), a land 
streamer (Method B), or a mechanical roll box (Method C).   
 
To set up using Method A, a subset, usually one quarter or one-half of the channels are 
deactivated so that there is a uniform channel number per shot record.  The active spread 
of geophones is rolled through the deactivated channels.  The inactive spread is 
continuous in the beginning, but as the active spread advances, there will be an increasing 
number of inactive channels up-line and a decreasing number of inactive channels down-
line.    
 
Example 3E For a roll-along end-on spread using Method A, with 48 channels and 24 

channels live for each shot, channels 25 through 48 are deactivated.   
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After clicking OK, the Geometry Toolbar in the main SCS window reflects the 
deactivation by graying out the symbols for geophones 25 through 48 (circled in red).    
 

 
 
The Shot Roll Increment and Active Spread Increment are both set to 1 so that the shot 
coordinate and the active set of geophones are advanced by one interval after each shot.  
Enable Auto Roll Up/Right is checked to roll to the “right” or up-line. 
 

 
End Example 3E. 
 
To set up using Methods B and C, none of the channels would be deactivated and both 
the shot and geophone coordinates would be advanced after each shot.  For Method C 
with a mechanical roll box, the dial that sets the connections between channels and 
geophones also needs to be advanced in synch with the coordinates after each shot.   
 
For a complete explanation of the SCS roll-along function, please refer to the separate 
manual specific to your seismograph.   
 
3.3.2.2 After Set-up – Acquiring, Displaying, and Quality Checking 2D MASW Data 
 
Once the set-up is complete, you are ready to begin data collection.  As discussed for 1D 
MASW surveys, perform the same system checks before starting acquisition, make the 
same adjustments to optimize the data display, and run the same data quality analyses.    
 
After you have collected the active source records and are satisfied with the data, 
continue to the passive source survey if applicable.  
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4 – Data Analysis Using the Wizard 
 
SeisImager/SW is capable of 1D and 2D MASW for active sources and MAM data 
analysis for passive sources.  The 1D analyses output a Vs curve and the 2D analysis 
outputs a Vs cross-section.   
 

4.1 Surface Wave Analysis Wizard 
 
As discussed in Sections 1 and 2, the modules Pickwin, WaveEq, and GeoPlot comprise 
SeisImager/SW and the Surface Wave Analysis Wizard automatically calls on functions 
from these three modules to walk you through the processing flows.  There is a flow for 
processing 1D MASW active source data (Section 4.1.1), MAM passive source data 
(Section 4.1.2), and 2D MASW active source data (Sections 4.1.3 and 4.1.3.1).  
 
This section provides an explanation of wizard operation, processing flows, and basic 
dialog box parameters.  Please refer to Sections 5 and 6 for complete description and 
explanation of menu items and dialog box parameters (including the Advanced menu 
items) and Section 7 for an ordered list of the functions used in the wizard so the 
processing flows can be manually reproduced.  
 
The general processing flows as follows: 
 
 
 
 
 
 
 
 
The wizard is based on the Enter key.  At any time you can manually override the wizard 
by entering the menus.  A complete 1D dataset is considered to consist of at least one 
active source file and a set of passive source files and a complete 2D dataset consists of a 
series of active source files (the total number will vary depending on the survey).  Passive 
source results can also be integrated with 2D MASW datasets for deeper control.  
Integration of datasets is done manually outside of the wizard (Section 4.2).    
 
 

Input data, 
edit 

Calculate 
dispersion 
curve, edit 

Create initial 
Vs model 
based on 

observed data

Run inversion to 
seek Vs model 
that best fits 

dispersion curve 
of observed data  
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4.1.1 Active Source 1D MASW Wizard 
 
Double-click on the Surface Wave Analysis Wizard icon.   
 

 
 
The Welcome to SeisImager/SW dialog box appears.  Select Active Source 1D MASW and 
click OK.  
 

 
 
The Pickwin module is launched.  
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The main Pickwin window appears.  The wizard calls functions from the File and Surface 
Wave Analysis menus.  Press the Enter key as instructed in the upper left hand corner of 
the window to begin. 
 

 
 
The first step is to input the active source data file.  Highlight the file and click Open.  
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The waveform file is displayed.  
 

 
 
If the unit labels displayed are incorrect, select the Edit/Display menu, Edit 
source/receiver locations.   
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The Geometry dialog box appears and the Units setting allows selection between meters 
and feet.  The Units setting will affect the unit labels shown in the dialog boxes as well as 
update the Minimum phase velocity default value used for picking the dispersion curve, 
which is 35 m/s or 150 ft/s.  Once set (and Pickwin is closed), the assigned units will be 
recalled for subsequent uses of the wizard.  (It is necessary to close Pickwin to register 
the new Units setting.  At the end of the wizard, simply close Pickwin to register the new 
Units setting.)   
 
The Geometry dialog box also reports the source and receiver coordinates saved in the 
file header at the time of acquisition.  If there are errors, correct them here by entering the 
applicable values for Shot coordinate and Group interval.  Click on Set to apply the new 
Group interval and to recalculate the Geophone coordinates.  Click OK when done.  
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In the waveform view, the settings can be modified to optimize the display.  All of these 
settings are common with SeisImager/2D for refraction data processing; refer to the 
SeisImager/2D manual included on the SeisImager CD for complete explanation.  The 

main functions needed are the Waveform amplitude  buttons, the Horizontal scale 

 buttons, the Vertical scale  buttons, and the Normalize  button.  
 
When done, press the Enter key to continue.  
 

 
 
Click Yes when ready to proceed.  
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Next, set the parameters for calculation of phase velocity.  Set the Phase Velocity End to 
suit the maximum velocity you expect for your site.       
 
The default value for Frequency End suits most cases.  To see the extent of fundamental 
mode velocity on the high frequency end, a higher value can be entered.  Click OK when 
done.  
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Next, set the parameters for picking the maximum amplitudes, which define the 
dispersion curve on the phase velocity-frequency plot.  The Minimum Frequency default 
value is 5 Hz assuming that 4.5 Hz geophones were used.  If other geophones were used, 
their natural frequency can be entered or use the default value to allow the software to 
attempt to pick amplitude maxima to that end (any bad picks can be manually deleted 
later).   
 
The Maximum Frequency reflects the value entered in the previous dialog box.  Click OK 
when done.  
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Once the calculations are complete, a phase velocity-frequency plot is displayed with the 
automatically determined maximum amplitudes shown as red points.     
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The default display settings for the phase velocity-frequency plot are Wiggle trace  

Shaded black .  Usually the dispersion curve is more obvious in color contours.  

Select the Fine color contour  button to switch to a color plot and use the Waveform 

amplitude  buttons, the Horizontal scale  buttons, and the Vertical scale 

 buttons to optimize the display.     
 
If you need to manually make or edit picks, you can do so by clicking the mouse at the 
desired pick location.  To help identify maxima, as you drag the mouse over the plot the 
actual amplitude values can be read on the bottom bar , where the value 
preceding the colon is the frequency and the value following is the amplitude.  To restore 
the automatically determined picks, select the Surface-wave analysis menu, Pick phase 
velocity (1D). 
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Save the dispersion curve picks if you would like to be able to input them again later.  
Select the File menu, Save pick file.   
 

 
 
Assign a file name with the extension .pvs and click Save.   
 

 
 
Once the file is saved, click OK.  
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Once the file is saved, the dispersion curve is displayed with a pink line connecting the 
picks.  Refer to Section 5.1.3 on how to re-input saved picks. 
 
Press the Enter key to continue.   
 

 
 
Click Yes when ready to proceed.  
 

 
 



 

SeisImager/SW Manual  4 – Data Analysis Using the Wizard  
Version 3.0, October 2009  Page 77 of 314 

Next, the WaveEq module launches and the dispersion curve is displayed.  Note that in 
WaveEq, Phase velocity is plotted on the vertical axis and Frequency is plotted on the 
horizontal axis.  From this point on, the wizard calls functions from the Dispersion curves 
and MASW (1D) menus.  
 

 
 
If the plotting scales need adjustment, select the View menu, Axis configuration.  
 

 
 
Enter the desired values for the X-axis and Y-axis Maximum scale and Interval.  Click OK 
when done.  
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Next, edit the dispersion curve as needed.  Commonly, there are noisy picks on the low 
and high frequency ends of the curve; a gate provides easy editing.  
 
Follow the instructions in the upper left-hand corner of the window.  The red gate is the 
active gate.  Use the right arrow key to position the gate at the frequency, phase velocity 
point up to which you want to delete.  Press the Enter key to activate the right-hand side 
gate and position it the same way using the left arrow key.  Press the Enter key when 
done.  
 

 
 
In addition to noisy picks on the edges of the curve, there may be outliers within the 

curve.  Outliers can be deleted by clicking the Selection  button, selecting the outlying 
points on the curve, then pressing the Delete key.  When done, unclick the Selection 
button.  
 
If the curve has noisy jitter, it can be smoothed by selecting the Dispersion curves menu, 
Smoothing (individual curves).  Upon selection, the curve will automatically be 
smoothed.   
 

 
 
When done, press the Enter key to continue.   
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Click Yes when ready to proceed.   
 

 
 
Next, set up the initial model of Vs with depth.  The software default setting is to 
calculate the initial model from the one-third-wavelength approximation.  For the Depth 
value, a good estimate to start with is one-half the spread length.  The default value for 
the Number of layers is suitable for most cases.  Click OK when done.  
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The initial model is displayed.  Press the Enter key to continue.   
 

 
 
Click Yes when ready to proceed.   
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Next, set the number of iterations for the inversion.  The software will iterate the number 
of times indicated to converge on the best fit of the initial model with the observed data.  
The default value of 5, up to 10, for Iteration is suitable for most cases.  Click OK when 
done. 
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Once the inversion is complete, the final Vs curve is displayed.  
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Click on the Show apparent velocity model  button to overlay the one-third-
wavelength approximation (green points), which is the best indicator of the actual depth 
range of penetration.  In the latest version of the software, by default, the shade of the 
model changes to light grey starting at the deepest apparent velocity to call attention to 
the limits of the data. 
 

 
 
If there is good control to a depth of 30 m (100 ft), select the View menu, Show AVS for 
IBC, to calculate and display the average Vs value.  
 

 



 

SeisImager/SW Manual  4 – Data Analysis Using the Wizard  
Version 3.0, October 2009  Page 84 of 314 

 
When done, press the Enter key to continue.   
 
Click Yes when ready to proceed.   
 

 
 
Lastly, save the result.  Assign a file name with the extension .rst and click Save.   
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After the file is saved, check the fit of the calculated and observed dispersion curves.  

Click on the Show one dispersion curve  button to display the original dispersion 

curve.  Click on the Comparison  button to overlay the calculated dispersion curve 
(black line) and visually assess the degree of mismatch.  The matching error between the 
two curves in units of time (ms) and as a percentage is also saved to a file called 
RMSE.txt in the dataset directory.  The error should be less than about 5% but will vary 
depending on the dataset.    
 
If there is a high degree of mismatch, it is likely due to dispersion curve anomalies such 
as sharp changes and/or outliers or due to low quality noisy picks on the low and high 
frequency ends of the curve.  The mismatch will also be evident in the final Vs curve, 
usually as an unrealistic velocity inversion or gradient.  Although the mathematical 
inversion may be able to model these aspects of the dispersion curve, surface waves by 
their physical nature cannot resolve relatively abrupt or small-scale velocity anomalies.  
The dispersion curve should be double-checked and the process re-run to improve the 
match.   
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4.1.2 Passive Source (Microtremor) 1D MAM Wizard 
 
The Passive Source 1D MAM Wizard process is essentially the same as for the Active 
Source 1D MASW Wizard (Section 4.1.1) with additional steps for setting up the MAM 
survey geometry.  This section assumes that you have already worked through the Active 
Source 1D MASW Wizard and are familiar with the steps and general functionality of the 
wizard.  The new parts of the process are covered in detail, but Section 4.1.1 should be 
referred to for complete explanation of the common steps.  The main difference between 
the two processing flows is the number of data files and how they are input.   
 
Double-click on the Surface Wave Analysis Wizard icon.  Select Passive Source 
(Microtremor) 1D MAM and click OK.  
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The main Pickwin window appears.  Press the Enter key to begin.  
 

 
 
The first step is to input the dataset; all the dataset files are input at one time.  Use the 
Shift key to highlight the first through last file in the dataset and click Open.   
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Once the selected files are open, click OK.   
 

 
 
The first in the group of waveform files is displayed.  Set the units if necessary.  
 

 
 
Unlike most active source data, it is usually difficult to evaluate the quality of passive 
source data by viewing the shot record in the time domain.  You can quickly transform 

the data into the frequency domain by clicking on the Frequency domain  button. The 
view will change to a plot of the frequency content or spectrum for each trace.     
 

After clicking on the Frequency domain button, click on the right Horizontal scale  
button or press the right arrow key a few times to expand the frequency scale.  What is 
ideal is similar frequency content from trace-to-trace and dominant energy in the lower 
end of the frequency scale.  The example spectrum plot below indicates high-quality 
passive source data.   
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To toggle back to the waveform view, click the Time domain  button.   
 

To scroll through the files, use the Show previous waveform  and Show next waveform 

 buttons. 
 
When done, from the waveform view, press the Enter key to continue.  
 

 
 
Click Yes when ready to proceed.   
 

 
 



 

SeisImager/SW Manual  4 – Data Analysis Using the Wizard  
Version 3.0, October 2009  Page 90 of 314 

Next, set the array geometry for the SPAC calculation.  Select which 2D array type was 
used and the Array size or select Linear array and enter the Receiver spacing and 
Number of receivers.  This example is based on a Triangle 10 array with an Array size of 
50 meters.  Click OK when done.  
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The rest of the steps are identical to the Active Source 1D MASW Wizard.  Proceed to 
calculate phase velocity and pick the dispersion curve.   
 
Set the Phase Velocity End to suit the maximum velocity you expect for your site.  
Passive source energy is generally traveling deeper and thus, at higher velocities so you 
will likely want to set a higher Phase Velocity End than what was used in the active 
source wizard.  
 
The default value for Frequency End suits most cases.  To see the extent of fundamental 
mode velocity on the high frequency end, a higher value can be entered.  Click OK when 
done. 
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The Minimum Frequency default value is 2 Hz.  If 4.5 Hz geophones were used, energy 
below 4.5 Hz may have been recorded, though dampened according to the sensitivity of 
the geophone.  It is suggested to leave the default value of 2 Hz to allow the software to 
attempt to pick the amplitude maxima to this end (any bad picks can be manually edited 
later).   
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Convert the phase velocity-frequency plot to fine color contours, adjust the gain, and 
check the automatically determined dispersion curve picks.  Save the dispersion curve 
picks if desired.  
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Once the dispersion curve is imported to WaveEq, edit the curve as necessary using the 
gates, the Selection button, and/or Smoothing (individual curves).   
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Set the maximum depth for the initial Vs model.  A good Depth estimate to start with is 
the length of the array.  Accept the default value or increase as desired for Iteration.  
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Once the inversion is complete, the final Vs curve is displayed.  For indication of the 

actual depth range of penetration, click the Show apparent velocity model  button to 
overlay the one-third-wavelength approximation.  If there is good control to a depth of 30 
m (100 ft), select the View menu, Show AVS for IBC, to calculate and display the average 
Vs value.  
 

 
 
Lastly, complete the wizard by saving the results and check the fit between the calculated 
and observed dispersion curves.   
 
Refer to Section 4.2 on how to combine active and passive source dispersion curves from 
a given site and obtain one high-resolution Vs curve over the entire sampled depth range. 
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4.1.3 Active Source 2D MASW Wizard 
 
The Active Source 2D MASW Wizard process is essentially the same as for the Active 
Source 1D MASW Wizard (Section 4.1.1) and Passive Source 1D MAM Wizard (Section 
4.1.2) with additional steps for setting up the 2D MASW survey geometry.  This section 
provides a complete treatment of the 2D MASW wizard process covering Pickwin, 
WaveEq, and GeoPlot so much of the detail will be familiar if you have already run the 
other processing flows.  Note that GeoPlot is its own standalone module for general data 
visualization.  In this manual, in Section 4.1.3.1, only the GeoPlot functions needed for 
viewing 2D MASW initial and final Vs cross-sections are covered.  As noted in Section 
1, GeoPlot will eventually be made available as a separate module; at that time, a full 
manual will also be released.   
 
Double-click on the Surface Wave Analysis Wizard icon.   
 

 
 
The Welcome to SeisImager/SW dialog box appears.  Select Active Source 2D MASW and 
click OK.  
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The Pickwin module is launched.  
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The main Pickwin window appears.  The wizard calls functions from the File and Surface 
Wave Analysis menus.  Press the Enter key as instructed in the upper left hand corner of 
the window to begin. 
 

 
 
The first step is to input the dataset; all the dataset files are input at one time.  This is 
done by making a new file list.  Select Yes: make new file list.   
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Use the Shift key to highlight the first through last file in the dataset and click Open.   
 

 
 
Once the selected files are open, click OK.     
 

 
 
Next, indicate if the source and receiver coordinates stored in the file headers should be 
used for the geometry.  Explanation of the wizard assumes that the correct source and 
receiver coordinates were saved to the file headers; working on that assumption, check 
Source position and Receiver position to apply the header information to the geometry.  
Click OK when done.   
 

 
 
A list of the files is presented in the File list dialog box.  Note that if the coordinates from 
the header are to be applied, they will not be reflected here in the Source, 1st Receiver, 
and Receiver columns; only the Apply source coordinates from file header and Apply 
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receiver coordinates from file header boxes will be checked.  (If coordinates need to be 
entered manually, click on Set up to enter the pattern that describes the geometry.  Refer 
to Section 5.1.4 for a full explanation of how to enter coordinates manually.)  Click OK 
when done.   
 

 
 
Next, assign the file list a unique alpha-character tag.  The characters indicated are 
prefixed by the letters “sx” and used to name all output from analysis of the dataset.  The 
files are automatically saved in the dataset directory.  Use the up and down arrow keys to 
increment or decrement a character and use the right and left arrow keys to toggle 
between characters.  Click OK when done.  
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The first in the group of waveform files is displayed.   
 

 
 
If the unit labels displayed are incorrect, select the Edit/Display menu, Edit 
source/receiver locations.   
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The Geometry dialog box appears and the Units setting allows selection between meters 
and feet.  The Units setting will affect the unit labels shown in the dialog boxes as well as 
update the minimum phase velocity default value, which is 35 m/s or 150 ft/s.  Once set 
(and Pickwin is closed), the assigned units will be recalled for subsequent uses of the 
wizard.  (It is necessary to close Pickwin to register the new Units setting.  At the end of 
the wizard, simply close Pickwin to register the new Units setting.)  Click OK when done. 
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In the waveform view, the settings can be modified to optimize the display.  All of these 
settings are common with SeisImager/2D for refraction data processing; refer to the 
SeisImager/2D manual included on the SeisImager CD for complete explanation.  The 

main functions needed are the Waveform amplitude  buttons, the Horizontal scale 

 buttons, the Vertical scale  buttons, and the Normalize  button.  
 

To scroll through the files, use the Show previous waveform  and Show next waveform 

 buttons.   
 
When done, press the Enter key to continue.  
 

 
 
Click Yes when ready to proceed with calculation and assignment of the geometry. 
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Once the geometry calculation is complete, the file list with geometry assignments is 
saved as an .xml file named with the tag set earlier in the process, click OK.  This list can 
later be opened directly without having to reassign the geometry.   
 

 
 
A plot of the geometry is displayed.  Press the Enter key to continue.   
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Click Yes when ready to proceed.  
 

 
 
Next, calculate the CMP cross-correlation gathers.  The First distance and Last distance 
are taken from the first and last coordinates of the receiver spread and the Bin size is 
automatically calculated as two times the receiver interval.  The default value for Bin size 
is recommended.  The effect of increasing the Bin size is to reduce the resolution of the 
final Vs cross-section.  Click OK when done.    
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Next, set the parameters for calculation of phase velocity for the CMP cross-correlation 
gathers.  Set the Phase Velocity End to suit the maximum velocity you expect for your 
site.       
 
The default value for Frequency End will suit most cases.  To see the extent of 
fundamental mode velocity on the high frequency end, a higher value can be entered.  
Click OK when done.  
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Next, set the parameters for picking the maximum amplitudes, which define the 
dispersion curve on the phase velocity-frequency plot.  The Minimum Frequency default 
value is 5 Hz assuming that 4.5 Hz geophones were used.  If other geophones were used, 
their natural frequency can be entered or use the default value to allow the software to 
attempt to pick amplitude maxima to that end (any bad picks can be manually deleted 
later).   
 
The Maximum Frequency reflects the value entered in the previous dialog box.  Click OK 
when done.  
 

 
 
Once calculation of phase velocity and picking of dispersion curves is complete, the picks 
are automatically saved as a .pvs file named with the applicable tag, click OK.  Refer to 
Section 5.1.2 on how to re-input saved picks.   
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The first in the group of CMP cross-correlation gathers is displayed.  To scroll through 

the files, use the Show previous waveform  and Show next waveform  buttons.   
 

 
 

To display a file with a specific geometry, click on the Geometry  button to toggle to 
the geometry view.  The geometry of the waveform file currently displayed in the 
waveform view is highlighted in red.  
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Use the Show previous waveform  and Show next waveform  buttons to select a 
geometry of a waveform file to display.   
 

 
 

Toggle back by clicking on the Waveform  button to display the selected file.   
 

 
 
When done, press the Enter key to continue.   
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Click Yes when ready to proceed.  
 

 
 
Next, the WaveEq module launches and the dispersion curves are displayed.  From this 
point on, the wizard calls functions from the Dispersion curves and MASW (2D) menus.  
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If the plotting scales need adjustment, select the View menu, Axis configuration.  
 

 
 
Enter the desired values for the X-axis and Y-axis Maximum scale and Interval.  Click OK 
when done.  
 

 
 
Press the Enter key to continue.   
 
Next, there is a series of three dispersion curve editing functions to remove low quality, 
noisy, and higher mode picks that are typically present on dispersion curves and can skew 
or cause instabilities in the inversion.  The default settings for these functions are suitable 
for most cases.  Any of the editing steps can be skipped by clicking No.  Refer to Section 
6.4 for a complete explanation of the dispersion curve editing functions.  
 
Select Yes.  
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The edited dispersion curves are displayed.  Press the Enter key to continue.   
 

 
 
Click Yes when ready to proceed.  
 

 
 
Select Yes.  
 

 
 
Follow the instructions in the upper left-hand corner of the window.  The red gate is the 
active gate.  Use the right arrow key to position the gate at the frequency, phase velocity 
point up to which you want to delete.  Press the Enter key to activate the right-hand side 
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gate and position it the same way using the left arrow key.  When done, press the Enter 
key to delete the picks outside of the gates.   
 

 
 
The edited dispersion curves are displayed.  Press the Enter key to continue.   
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Click Yes when ready to proceed.  
 

 
 
Select Yes. 
 

 
 
The edited dispersion curves are displayed. 
 

 
 
This is the last editing step.  Press the Enter key to continue.   
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Click Yes when ready to proceed.  
 

 
 
Next, set up the initial models of Vs with depth.  These individual curves are used to 
interpolate an initial cross-sectional model.  The software default setting is to calculate 
the initial models from the one-third-wavelength approximations.  For the Depth value, a 
good estimate to start with is one-half the spread length.  The default value for the 
Number of layers is suitable for most cases.  Click OK when done.  
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Once the initial cross-sectional model is calculated, the number of curves used in the 
model is reported, click OK.  
 

 
 
The initial model file is automatically saved, click OK. 
 

 
 
The first in the group of individual initial models is displayed.   
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To control the velocity curve display, use the Velocity section 1  and Velocity section 

next  buttons to view one, or three curves at a time, respectively.  With either setting, 

the Show previous  and Show next  buttons and the Home  and End  buttons 

allow you to move through displays.  The Velocity section all  button displays all 
velocity curves.   
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Click on the Show apparent velocity model  button to overlay the one-third-
wavelength approximation (green points), which is the best indicator of the actual depth 
range of penetration.  In the latest version of the software, by default, the shade of the 
model changes to light grey starting at the deepest apparent velocity to call attention to 
the limits of the data. 
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For the dispersion curves, the Dispersion curve 1  and Dispersion curve next  

buttons, the Show previous  and Show next  buttons, the Home  and End  

buttons, and the Dispersion curve all  button, function the same as described for the 
velocity curve display.   
 
When done, press the Enter key to continue.  
 

 
 
Click Yes when ready to proceed.  
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Select No: show initial model to display the initial cross-sectional model in GeoPlot.  (To 
skip this step, select Yes: perform inversion.)   
 

 
 
The GeoPlot module launches, click OK.  Refer to Section 4.1.3.1 for an explanation of 
the GeoPlot functions used for viewing initial Vs cross-sections.  
 

 
 
When done viewing the initial model in GeoPlot, press the Enter key to save the file and 
then return to WaveEq to run the inversion.  
 
In WaveEq, press the Enter key and click Yes when ready to proceed.  
 

 
 
Select Yes: perform inversion.   
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Set the number of iterations for the inversion.  The software will iterate the number of 
times indicated to converge on the best fit of the initial model with the observed data.  
The default value of 5, up to 10, for Iteration is suitable for most cases.  Click OK when 
done.   
 

 
 
Note that depending on the dataset size, the inversion can be computationally intensive 
and may take some time to complete.  Also, the higher the Iteration value, the longer the 
process will take.  In the Windows Task Manager, WaveEq may report as “Not 
Responding”, but if the memory usage is dynamically changing this indicates the process 
is running properly. 
 
Once the inversion is completed, click OK.  
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Once the final cross-sectional model is calculated, the number of curves used in the 
model is reported, click OK.  
 

 
 
The final model file is automatically saved, click OK. 
 

 
 
The first in the group of individual final models is displayed.   
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Check the fit of the calculated and observed dispersion curves.  Click on the Show one 

dispersion curve  button to display the original dispersion curve.  Click on the 

Comparison  button to overlay the calculated dispersion curve (black line) and 
visually assess the degree of mismatch.  The matching error between the two curves in 
units of time (ms) and as a percentage is saved to a file called RMSE.txt in the dataset 
directory.  The error should be less than about 5% but will vary depending on the dataset.    
 
If there is a high degree of mismatch, it is likely due to dispersion curve anomalies such 
as sharp changes and/or outliers or due to low quality noisy picks on the low and high 
frequency ends of the curve.  The mismatch will also be evident in the final Vs curve, 
usually as an unrealistic velocity inversion or gradient.  Although the mathematical 
inversion may be able to model these aspects of the dispersion curve, surface waves by 
their physical nature cannot resolve relatively abrupt or small-scale velocity anomalies.  
The dispersion curves should be double checked and the process re-run to improve the 
match.   
 
Press the Enter key to continue.   
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Click Yes to proceed.  
 

 
 
The GeoPlot module launches again to display the final model, click OK.  Refer to 
Section 4.1.3.1 for an explanation of the GeoPlot functions used for viewing final Vs 
cross-sections.  
 

 
 
Refer to Section 4.2 on how to combine active and passive source dispersion curves for a 
given site and maximize the depth range of the cross-section.   
 
4.1.3.1 The GeoPlot Module Surface Wave Analysis Functions 
 
After the Surface Wave Analysis Wizard launches GeoPlot the main GeoPlot window 
appears and the subject model is displayed.  The subject model may be an initial or final 
model.  The model is outlined in red to indicate is it active for editing.  
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To optimize the display of the model, first select the Scale menu, Fit in window to 
maximize the display area.   
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Click Yes to auto-scale the display.  
 

 
 

Use the Enlarge scale  and Reduce scale  buttons to further adjust the plot size.   
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If the axes need adjustment, select the View menu, Axis configuration.   
 

 
 
Enter the desired values for the X-axis and Y-axis Min, Max, and Interval.  The unit label 
fields reflect the units imported with the model from WaveEq.  To make changes to the 
labels enter the desired text in the Unit fields.  
 

 
 
When Show grid lines is checked, blue horizontal and vertical lines will be displayed at 
each tick interval.  Checking Set Interval (and Max) automatically will allow the tick 
intervals to dynamically decimate when the scale is reduced to prevent the axis labels 
from overlapping; the Max values cannot be fixed in this mode.  Reverse X-axis direction 
decreases the horizontal scale to the right.  Decimal places 0 (None) or 1 sets the number 
of significant digits for the axis tick interval values.  When Depth (the default) is selected 
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for the Vertical axis, the values are positive below zero, conversely, when Elevation is 
selected, the values are negative below zero.   
 
If the cross-section display extends beyond the deepest apparent velocity indicated by the 
one-third wavelength approximation, it is recommended that the display be adjusted to 
that depth to prevent interpretation beyond the constraints of the data.  Enter the deepest 
extent of the display in the Y-axis Min field.  The cross-section will be uniformly 
shortened to that value.  Click OK when done.  
 

 
 
To shorten the cross-section non-uniformly, select the Edit menu, Extent of deepest layer, 
Set with mouse.   
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Starting on the left vertical axis and ending on the right vertical axis, select new depth 
points using the left mouse button to define the base of the cross-section.  The best guide 
to what depth points should be selected will be the fold taper.  A minimum of two depth 
points are required.     
 

 
 
Next, select the View menu, Contour interval, Automatic, Linear scale, to automatically 
adjust the contour interval.   
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Click the Fine color contour  button to increase the display resolution.   
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To save a custom contour file so that it can be applied again later, select the View menu, 
Contour, Save contour file.  
 

 
 



 

SeisImager/SW Manual  4 – Data Analysis Using the Wizard  
Version 3.0, October 2009  Page 133 of 314 

Assign a file name with the extension .txt and click Save.  
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Next, edit the title of the cross-section by selecting the View menu, Labels.  
 

 
 
Enter the desired text in the Title, Scale, and Units fields and click OK when done.  
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If you do not want to display the Title, select the View menu, Labels to display and 
uncheck Title.  
 

 
 
Now is a good time to save the file.  If you are running the wizard, press the Enter key, 
and the GeoPlot file is automatically named and saved with the extension .geo, click OK 
and return to WaveEq to continue the wizard.   
 

 
 
To save the file by hand, select the File menu, Save GeoPlot file as.  
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Assign a file name with the extension .geo and click Save. 
 

 
 
When you are done editing, to deactivate the cross-section and turn off the red outline, 
select the Edit menu, Select section to edit, none. 
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To capture an image of the cross-section for report graphics, select the Edit menu, Copy 
to clipboard, and then paste the image into the program of choice.   
 

 
 
Copy to clipboard (option) allows you to select which features are included with the 
image capture.  
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To output the cross-section data in text format for input into other data visualization 
programs, select the File menu, Save (x, z, variable) formatted file (.txt).   
 

 
 
Assign a file name with the extension .txt and click Save. 
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Confirm the x-value range of data points to output and click OK.  
 

 
 
The file has a space-delimited format with the x-value, z-value, and velocity at that z-
value listed in rows.  
 

 
 
 



 

SeisImager/SW Manual  4 – Data Analysis Using the Wizard  
Version 3.0, October 2009  Page 140 of 314 

Some other useful GeoPlot functions include the following:  
 

• opening and appending other cross-sections  
• applying a saved contour file  
• displaying the contour interval values 
• inverting and reversing the velocity scale  
• applying settings from one cross-section to others 

 
 
More than one cross-section may be displayed at one time, for example the initial and 
final models for a given dataset.  With one cross-section already open, select the File 
menu, Open GeoPlot file, to open and append another cross-section to the display.   
 

 
 
Select to Append to present data and click OK.  
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To select between cross-sections, click on the cross-section number.  When selected, the 
circle around the cross-section number and the cross-section outline turns red.  When 
there is more than one cross-section displayed, select the View menu, Select section(s) to 
display should you wish to uncheck a cross-section to remove it from the display.  
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To change the vertical separation between the cross-sections, select the View menu, 
Vertical section spacing. 
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Enter the desired spacing and click OK.  
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To apply a saved custom contour file to another cross-section, select the View menu, 
Contour, Open contour file.  
 

 
 
Highlight the contour file and click Open.  
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To overlay the values of the contour intervals, select the View menu, Contour interval 
values, Show values.   
 

 
 

 
 
If the font size of the contour interval values needs to be increased, select the View menu, 
Contour interval values, Set up. 
 



 

SeisImager/SW Manual  4 – Data Analysis Using the Wizard  
Version 3.0, October 2009  Page 146 of 314 

 
 
Increase or decrease the Font size as desired.  The default Minimum separation at which 
the values appear suits most displays.  If No fill is checked (the default), there will be no 
background behind the values.  Uncheck No fill to turn on a white background.  
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To invert the color gradient of the scale, select the View menu, Invert scale.   
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To flip the direction of the scale so that it increases downwards, select the View menu, 
Reverse scale.   
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To apply the settings for a given cross-section in the current display, select the Edit 
menu, Apply settings to other sections.   
 

 
 
Check the Settings to be applied from the active Section No. to indicate which attributes 
should be applied to other cross-sections checked under Sections to be applied.  
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4.2 Combining Active and Passive Source Results 
 
Typically MASW datasets will have higher frequency content and MAM datasets will 
have lower frequency content.  Once active and passive source dispersion curves are 
picked for a given site, it is simple to combine the curves to obtain the highest resolution 
over the entire sampled depth range.  This section assumes that you have already worked 
with the wizard and are familiar with the processing flow.   
 

4.2.1 Combining 1D MASW and MAM Results 
 
Double-click on the WaveEq icon.   
 

 
 
Open the dispersion curve result file for either the 1D MASW active or MAM passive 
source dataset by selecting the File menu, Open velocity or dispersion curve file (.rst).   
 

 
 
For this example, the passive source result file is opened first.  In general, it is best to 
input raw dispersion curves so that any smoothing is applied to the composite curve.  
Highlight the file and click Open.   
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Use the same File menu function to open the result file for the 1D MASW dataset.   
 

 
 
To combine the 1D MASW dispersion curve with the MAM curve, select Append to 
present data.  Click OK when done. 
 

 
 
If you had more dispersion curves to append, say from additional active source shots for 
the same spread, repeat these steps.  
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The dispersion curves will typically have some overlap.  If the curves are not aligned, 
double-check the picks.  Usually the problem lies in noisy or spurious picks on the high 
frequency end of the passive source dispersion curve and/or the low frequency end of the 
active source dispersion curve. 
 

 
 
Select the File menu, Save 1D phase velocity curve file (.rst) to save the combined results 
as a new file.  
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Assign a file name with the extension .rst and click Save.  
 

 
 
Edit the dispersion curve as needed and save the edited results as a new file if desired.  
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Generate an initial model by selecting the MASW (1D) menu, Initial model.  
 

 
 
Set the maximum depth for the initial model.  
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Run the inversion by selecting the MASW (1D) menu, Inversion.  
 

 
 
Accept the default value or increase as desired for Iteration. 
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Once the inversion is complete, the final Vs curve is displayed.   
 

 
 
In the dispersion curve view, compare the observed and calculated dispersion curves.   
 

 
 
Save the final result by selecting the File menu, Save 1D phase velocity curve file (.rst).   
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4.2.2 Combining 2D MASW and MAM Results 
 
Double-click on the WaveEq icon.   
 

 
 
Open the dispersion curve result file for a 2D MASW dataset by selecting the File menu, 
Open 2D phase velocity curve file (.pvs).   
 

 
 
In general, it is best to input raw dispersion curves so that any smoothing is applied to 
composite curves.  Highlight the file and click Open.  
 

 
 
The number of imported dispersion curves is shown, click OK.  
 

 
 



 

SeisImager/SW Manual  4 – Data Analysis Using the Wizard  
Version 3.0, October 2009  Page 158 of 314 

The first in the group of dispersion curves is displayed.   
 

 
 
Open the dispersion curve from the MAM dataset by selecting the File menu, Open 1D 
phase velocity curve file (.rst).   
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Highlight the file and click Open.  
 

 
 
Select Append to present data to combine the MAM dispersion curve with the 2D 
MASW dispersion curves.  Click OK when done. 
 

 
 
Next, a prompt asks whether the MAM dispersion curve should be appended to only the 
currently displayed 2D MASW dispersion curve or to all of the 2D MASW curves.  The 
MAM dispersion curve should be appended to each MASW curve.  If it is only appended 
to one MASW curve, it will create a velocity anomaly at depths with no adjacent data.  
Note that appending the MAM dispersion curve to all MASW curves effectively 
extrapolates the MAM dispersion curve across the 2D MASW survey line.  Considering 
that the horizontal resolution of MAM data is approximately equal to the sampled depth, 
extrapolating MAM results across a 75 or 100 m long 2D MASW survey line is 
reasonable.  However, as this is an extrapolation, it should be done with care and is not 
recommended where large variations in velocity are thought to exist. 
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Select Yes to append the MAM dispersion curve to each of the 2D MASW dispersion 
curves.  
 

 
 
The first in the group of composite dispersion curves is displayed.  The MAM and 
MASW dispersion curves will typically have some overlap.  If the curves are not aligned, 
double-check the picks.  Usually the problem lies in noisy or spurious picks on the high 
frequency end of the passive source dispersion curve and/or the low frequency end of the 
active source dispersion curve.  
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Select the File menu, Save 2D phase velocity curve file (.pvs) to save the combined 
results as a new file.  
 

 
 
Assign a file name with the extension .pvs and click Save.  
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Edit the dispersion curves as needed and save the edited results as a new file if desired.  
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Generate an initial model by selecting the MASW (2D) menu, Initial model. 
 

 
 
Set the maximum depth for the initial model.  
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Run the inversion by selecting the MASW (2D: All data) menu, Inversion.   
 

 
 
Accept the default value or increase as desired for Iteration. 
 

 
 
Note that depending on the dataset size, the inversion can be computationally intensive 
and may take some time to complete.  Also, the higher the Iteration value, the longer the 
process will take.  In the Windows Task Manager, WaveEq may report as “Not 
Responding”, but if the memory usage is dynamically changing this indicates the process 
is running properly. 
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Once the inversion is complete, the first in the group of individual final models is 
displayed. 
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Display the final cross-sectional model in GeoPlot by selecting the MASW (2D) menu, 
Show 2D velocity model.   
 

 
 

 
 
Save the final model display as a .geo file by selecting the File menu, Save GeoPlot File.  
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Assign a file name with the extension .geo and click Save.  
 

 
 
In the dispersion curve view, compare the observed and calculated dispersion curves.   
 

 
 
Save the final result by selecting the File menu, Save 2D phase velocity curve file (.pvs).  
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5 – The Pickwin Module Surface Wave Analysis Functions 
 

5.1 File Menu 
 
The File menu functions essential or uniquely used for surface wave data processing are 
covered in this section.  For a complete description of the File menu functions common 
to SeisImager/SW and SeisImager/2D, refer to the separate SeisImager/2D manual 
included on the SeisImager CD.   
 

  
 

5.1.1 File Menu: Open SEG2 File  
 
To open a 1D MASW active source data file in SEG-2 format, select Open SEG2 file.   
 
Depending on the model of seismograph used to collect the data, the Files of type setting 
may need adjustment for SEG-2 formatted files.  Geometrics seismographs use the file 
extension .dat and OYO seismographs use the extension .sg2.  
 

See Section 5.1.1 

See Section 5.1.2,  
Section 5.1.3, and  
Section 5.1.4 

See Section 5.1.5 
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After setting the Files of type, highlight the file and click Open.   
 

 
 

5.1.2 File Menu: Open Synthetic Waveform  (.8hd) File 
 
To open a waveform file generated from a synthetic velocity model, select Open synthetic 
waveform (.8hd) file.  Highlight the file and click Open.   
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5.1.3 File Menu: Open Pick File 
 
To use this function properly you should start with a new instance of Pickwin, not one in 
which data has already been processed.  Double-click on the Pickwin icon to start a new 
instance; you need not close any other open Pickwin windows beforehand.  

Open pick file is used to open a file of saved dispersion curve picks with the file 
extension .pvs.  First the waveform file(s) from which the dispersion curve picks were 
derived should be opened by selecting the applicable Open __  file function or the Open 
file list function.  Next, select Open pick file.  Adjust the Files of type setting to show 
Phase-velocity data (*.pvs) types, highlight the file, and click Open. 
 

 
 
The dispersion curve picks will not be visible until the phase velocity is recalculated.  
Refer to Section 5.3 on how to calculate phase velocity.  
 

5.1.4  File Menu: Save Pick File 
 
To save dispersion curve picks, select Save pick file.  Assign a file name with the 
extension .pvs and click Save.  
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Confirmation that the file has been saved is displayed, click OK.  
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In the phase velocity-frequency plot view, the picks will be connected by a pink line.  
 

 
 

5.1.5  File Menu: Group (File List) 
 
The functions included in Group (File List) allow processing of a range of records, as 
with a MAM or 2D MASW dataset.  
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5.1.5.1 File Menu: Group (File List): Make File List 
 
A File list is an inventory of data files from any given survey and includes essential 
information for each waveform trace such as the associated field file identification 
number and source and receiver locations.  For surveys where multiple files are processed 
together, such as MAM or 2D MASW, the dataset must be input by making a file list.   
 
To make a list of files, select Make File List.  After setting the Files of type, highlight the 
set of data files to be opened by using the Shift key to select a range of files or the 
Control key to select individual files.  If All files is showing for the Files of type setting, 
take care not to inadvertently select non-data files as this will cause an analysis error.  
 

 
 
Confirmation that the files are input is displayed, click OK.  
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Next, you will be prompted to set up the geometry.  For MAM datasets, the source 
locations are non-applicable and the geometry of the spread/array is set in another 
separate dialog box.  Any coordinates saved in the file headers are not needed, so leave 
the boxes for Source position and Receiver position unchecked and click OK.  
 

 
 
Next, the File list dialog box presents the data files listed by file ID.  No action is needed 
for MAM datasets.  Click OK to proceed to viewing the waveform files.  
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For 2D MASW datasets, if the geometry was saved in the file headers during acquisition, 
check Source position and Receiver position to apply those coordinates and click OK.  
 

 
 
Next, the File list dialog box presents the data files listed by file ID.  Even if Source 
position and Receiver position were checked in the previous dialog box, note that the 
actual values from the file headers will not yet be shown here in the Source, 1st Receiver, 
and Receiver int. columns.  Checking Source position and Receiver position in the 
previous dialog box activates the Apply source coordinates from header and Apply 
receiver coordinates from header options in this dialog box.  If those options are 
checked, although not shown, the coordinates from the file headers will be applied.  
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If coordinates are to be imported from the file headers, confirm the options Apply source 
coordinates from header and Apply receiver coordinates from header are checked.  Click 
OK to proceed to viewing the waveform files.   
 
If coordinates are not to be imported from the file headers, coordinate values can be 
entered here in the Source, 1st Receiver, and Receiver int. columns individually or by 
setting up and applying a geometry pattern via the Set up button.  The default Set up 
parameters are as shown below.   
 

 
 
1st Source is the location of the first shot.  The Source interval is the spacing between 
each shot.  
 
For a dataset collected with a rolling spread, that is, the geophone locations were not 
fixed, check the Variable receiver option.  The Offset from source to 1st receiver is the 
distance from the location of the shot to the location of the nearest live geophone (the 
near offset).  It is assumed that the line has been shot from lowest to highest channel 
number, indicated by a positive polarity for the Source interval.  If the data was shot 
toward the lowest channel number, the Source Interval should have a negative polarity to 
indicate that the source rolled this direction.  This case can occur when using a 
Geometrics seismograph where the channel nearest the seismograph (and PC controller) 
is the highest by default and the first shot was located at this end of the line.  
 
For a dataset collected with a fixed receiver spread where the shot location was 
incremented through the spread, check the Fixed Receiver option.  The First receiver 
position is the location of the first live geophone.   
 
The Receiver interval is the spacing between each geophone.  
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Example 5A  Set up a Fixed receiver geometry for a 2D MASW dataset (201.dat-
225.dat) with no file header coordinates.  The dataset consists of 25 shots 
with the first and last shots off-end at 0.5 m near offsets, 24 geophones 
located at 0 to 23 m, and equal source and receiver intervals of 1 m. 

 
Starting at the geometry prompt, Source position and Receiver position are left 
unchecked.  
 

 
 
The File list dialog box shows the file IDs but only default values for the Source, 1st 
Receiver, and Receiver int. columns.  Also, Apply source coordinates from header and 
Apply receiver coordinates from header are unchecked.  
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Through the Set up dialog box, enter and apply the applicable geometry values.  
 

 
 
The File list dialog box reflects the geometry pattern.   
 

 
End Example 5A. 
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Example 5B  Set up a Variable receiver geometry for a 2D MASW dataset (201.dat-
225.dat) with no file header coordinates.  The dataset consists of 25 shots 
with a near offset of 4 m, 24 geophones located at 0 to 46 m, and equal 
source and receiver intervals of 2 m. 

 
Starting at the geometry prompt, Source position and Receiver position are left 
unchecked.  
 

 
 
The File list dialog box shows the file IDs but only default values for the Source, 1st 
Receiver, and Receiver int. columns.  Also, Apply source coordinates from header and 
Apply receiver coordinates from header are unchecked.  
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Through the Set up dialog box, enter and apply the applicable geometry values.  
 

 
 
The File list dialog box reflects the geometry pattern.   
 

 
End Example 5B. 
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Additional information on the File list dialog box includes the Next and Back buttons, 
which allow scrolling through the next, or last, ten file IDs, respectively.  For users of 
OYO seismographs an auxiliary channel is automatically recorded; the number of the 
auxiliary channel can be indicated by clicking on the Set # of Aux. button.  If any file 
needs to be deleted from a list, check the Edit box next to that file ID and click on the 
Delete button.   
 
Once geometry assignment in the File list dialog box is complete, click OK to save the 
changes and proceed to viewing the waveform files.  
 
To view the assigned geometry again, the File list dialog box can be directly accessed at 
any time through the Show File List function.      
 
5.1.5.2 File Menu: Group (File List): Open File List 
 
To open an existing file list that was previously saved in a .txt or .xml format, select Open 
File List.  Highlight the file list and click Open.   
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The waveform files with assigned geometry are displayed.   
 

 
 
5.1.5.3 File Menu: Group (File List): Save File List (Text) 
 
Once a file list has been generated, it can be saved as a text file by selecting Save file list 
(text).  File lists should always be saved in the dataset directory.   
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Assign a file name with the extension .txt and click Save.  
 

 
 
The file is formatted in space-delimited columns by file ID, shot location, geophone 
location, receiver interval, and auxiliary channel number.  
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5.1.5.4 File Menu: Group (File List): Save File List (XML) 
 
Once a file list has been generated, it can be saved as an .xml file by selecting Save file 
list (xml).  File lists should always be saved in the dataset directory.  The XML format 
and the dataset directory are the default format and file location used by the 2D MASW 
wizard.   
 
Assign a file name with the extension .xml and click Save.  
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The file is formatted in XML with general line information at the top followed by the 
shot location, geophone location, receiver interval, and auxiliary channel number for each 
file ID. 
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5.1.5.5 File Menu: Group (File List): Show File List 
 
To open the File list dialog box, select Show file list.  The File list dialog box is displayed 
and reflects the current geometry assignment for the subject dataset.  
 

 
 
5.1.5.6 File Menu: Group (File List): Set Up Geometry 
 
In SeisImager/SW, the 2D MASW process requires calculation of CMP locations (refer 
to Section 3.3.1 for explanation) before the dispersion calculation.  The 2D MASW file 
list with source and receiver locations is used to find the CMP locations.   
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To calculate CMP locations for a 2D MASW file list, select Set up geometry.  First, the 
number and location of CMPs are calculated using the source and receiver coordinates.  
A report of the number of sources and receivers detected in the file list and the number of 
CMPs calculated from the source and receiver coordinates is displayed.  Click OK.   
 

 
 
Next, the total number of waveform traces and the maximum range of the survey 
geometry are calculated and reported.  Click OK. 
 

 
 
Up to this point, the waveforms have been handled as an assembly of traces as opposed to 
individual traces.  Obviously, at the time of acquisition traces are assembled in a shot 
record (or “shot gather”) by common shot location.  At this point, the waveform for each 
trace will be individually assigned a CMP coordinate so that at a later step the traces can 
be assembled into CMP cross-correlation gathers by CMP location.  If no errors were 
detected in the previous calculations, click OK to Input waveform data.   
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The number of traces assigned a CMP coordinate is reported and should equal the Total 
number of shot gather traces reported previously.  Click OK.  
 

 
 
Once complete, a plot of the source-receiver geometry is displayed.  
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Table 5 summarizes all the attributes used in geometry plots.  The horizontal axis, 
Distance, is the distance along the survey line.  The vertical axis, Shot No., is the number 
of the shot as the data was sequentially collected.   
 

Table 5.  2D MASW Geometry Plot Attributes  
 
Circle/Dot Color 

 
Meaning 
 

 
Teal blue 

 
Shot point 
 

Yellow  Receiver for which a trace has been read  
 

Dark blue Receiver for which no trace has been read 
 

Red  Receiver for which traces are selected and can be viewed 
in the waveform display  
 

Black  Grid point (no meaning in actual geometry) 
 

 

The Show previous waveform  and Show next waveform  buttons can be used in 
the geometry view to select a waveform shot record to display, as well these buttons can 
be used to scroll through waveform files in the waveform view.  Click on the Waveform 

 and Geometry  buttons to toggle between the views.   
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If there is an error and no waveform data is input, the geometry plot will appear with a 
dark blue circle for each receiver missing a waveform trace.  If an input error occurs, 
double check that all the dataset files are in one directory and that the geometry 
assignment is correct; then start over with the Set up geometry process.   
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5.2 Edit/Display Menu 
 
The single Edit/Display menu function essential or uniquely used for surface wave data 
processing is covered in this section.  For complete description of the Edit/Display menu 
functions common to SeisImager/SW and SeisImager/2D, refer to the separate 
SeisImager/2D manual included on the SeisImager CD.   
 

 
 

5.2.1 Edit/Display Menu: Edit Source/Receiver Locations 
 
To change the unit labels shown in the displays and in the dialog boxes, select Edit 
source/receiver locations to open the Geometry dialog box. 
 
The Geometry dialog box allows selection of units and reports the coordinates saved in 
the file header at the time of acquisition or in the file list for a single waveform file 
currently displayed.   
 

See Section 5.2.1 
 



 

SeisImager/SW Manual 5 – The Pickwin Module Surface Wave Analysis Functions 
Version 3.0, October 2009  Page 192 of 314 

To set the unit labels, select between meters and feet.  The unit setting also updates the 
minimum phase velocity default value, which is 35 m/sec or 150 ft/s.  Once set (and 
Pickwin is closed), the assigned units will be recalled for subsequent uses of the program.  
(It is necessary to close Pickwin to register the new Units setting.)   
 

 
 
The Geometry dialog box can also be used to set up or edit the source-receiver geometry 
for single shot records for 1D MASW.  For 2D MASW, the File list and Set up geometry 
functions should be used. 
 
To set up or edit the geometry for a single 1D MASW shot record, enter the location of 
the shot in Shot coordinate.  Enter the Group interval and First geophone coordinate, 
then click on Set to calculate all the Geophone coordinates.  Next and Back can be used to 
scroll through the coordinate values in sets of six channels.  Click OK when done to 
apply the changes.  A new SEG-2 file will need to be saved by selecting the File menu, 
Save SEG2 file to preserve the changes, otherwise they will need to be made each time 
the shot record is input.    
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5.3 Surface-Wave Analysis Menu 
 
The Surface-Wave Analysis menu contains the functions needed for calculating phase 
velocity and picking dispersion curves.  The menu is divided into three sections, the top 
for functions that pertain to 1D MASW and MAM data processing, the middle for 2D 
MASW data processing, and the bottom for an additional function for MAM data 
processing.  For purchases of SeisImager/SW-1D, the top and bottom sections are active 
and the middle section is grayed out.  For purchases of SeisImager/SW-2D, all three 
sections are active.     
 

 
 

5.3.1 Surface-Wave Analysis Menu: Phase Velocity-Frequency 
Transformation 

 
To transform one MASW shot record or CMP cross-correlation gather from the time to 
frequency domain and to calculate the phase velocity for each frequency, select Phase 
velocity-frequency transformation.   
 
For a MAM dataset, the same function is used to generate a phase velocity-frequency 
plot, but first the dataset must be processed by the 2D Spatial Autocorrelation function.  
Refer to Section 5.3.7 for a complete explanation.  
 
 

1D functions  

2D functions  

MAM function (in addition 
to 1D functions)  
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Once selected, set the boundaries for the phase velocity calculation in the Phase velocity-
frequency transformation dialog box.  The radio buttons can be ignored as they only 
apply when using the software on a seismograph with integrated PC.   
 

 
 
The Start Phase Velocity and Start Frequency are set fixed at 0.  
 
For End Phase Velocity, enter the approximate maximum velocity expected for the site.  
If you find that the end velocity in the calculated phase velocity-frequency plot is too low 
or too high, the calculation can simply be re-run. 
 
For End Frequency, adjust the default value to enclose the bandwidth of fundamental 
mode surface wave signal.  The default value of 30 Hz is suitable for most cases.  Again, 
it is simple to adjust this value and re-run the calculation if you want to experiment with 
this setting.     
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The default dialog box format hides the Advanced menu.  Clicking on Advanced menu 
reveals the rest of the parameters with default values for active source (shown on left) 
and passive source (shown on right) processing.  These parameters are automatically 
updated by the software depending on the type of data being processed.  Typically, none 
of the settings need to be changed.     
 

   
 
The Phase Velocity Interval defines the resolution at which the calculation steps through 
the range of velocities indicated.  Increasing this value reduces the resolution.  During the 
picking stage, if the phase velocity-frequency plot lacks resolution, the resolution can be 
improved by reducing this value.  
 
Mode of Shot gather or CMP gather applies to 2D MASW processing where shot gather 
traces are assembled into CMP gathers.  This parameter is automatically updated by the 
software depending on the type of data being processed.  
 
Direction of Forward means that the shot coordinate is less than the coordinate of the 
first geophone.  Backward means the shot coordinate is greater than the coordinate of the 
first geophone.  The software assumes that that the same gain was used on all traces and 
automatically attempts to determine the direction.  This is done by comparison of the 
amplitudes of the first and last traces.  If the last trace amplitude is smaller, the software 
assumes a Forward direction and vice-versa for Backward.  If you have recorded with 
individual gain settings, you may want to check that the software correctly determined 
the direction.  
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The Frequency resolution controls how finely phase velocity is calculated.  If this value 
is increased, the resolution will be reduced.  This value cannot be less than 1 and must be 
an integer.   
 
The Offset range used in transformation sets the range of traces used in the 
transformation.  This is a difference, not actual coordinates.  Offset is the distance from 
the shot to any given receiver.  This is mainly used for muting out near-source effects in 
2D MASW data processing and is non-applicable for 1D MASW.   
 
Method indicates what procedure will be used.  This parameter is automatically updated 
by the software depending on the type of data being processed.  For active source data 
processing, the Method is Phase shift.  For passive source data processing, the Method is 
SPAC by 2D.  The Wave number limit is the high frequency limit used to avoid aliasing 
when fitting Bessel functions in the SPAC process.  The default value of 100 is relatively 
large and suitable for most cases. 
 
Upon completion of the transformation, a phase velocity-frequency plot is displayed.  A 
trend of peak “amplitudes”, which correspond to the degree of fit for each frequency, 
should be obvious.  It is typical for the widths of the peaks to broaden as the frequency 
decreases because the signal-to-noise ratio tends to decrease with frequency.   
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5.3.2 Surface-Wave Analysis Menu: Pick Phase Velocity (1D) 
 
To automatically pick the maximum amplitudes on the phase velocity-frequency plot 
which define the dispersion curve, select Pick Phase Velocity (1D).   
 
Set the frequency bounds for automatic picking in the Min. and Max. Frequency dialog 
box.  For active source data processing (shown on left), the Minimum Frequency default 
value is 5 assuming that 4.5 Hz geophones were used. 
 
For passive source data processing (shown on right), the Minimum Frequency default 
value is 2 assuming that 2 Hz seismometers were used.  If the dataset was acquired with 
4.5 Hz geophones, the Minimum Frequency can be increased to 5 if desired; however, 
there may be signal below 5 Hz and any spurious picks made between 2 and 5 Hz can 
easily be deleted manually.  It is not crucial that this value be precisely correct.   
 
The value shown for the Maximum Frequency reflects in Fourier space the value closest 
to that set in the Phase velocity-frequency transformation dialog box.   
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The default dialog box format hides the Advanced menu.  Clicking on Advanced menu 
reveals the rest of the parameters with default values for active source (shown on left) 
and passive source (shown on right) processing.  These parameters are automatically 
updated by the software depending on the type of data being processed.  Typically, none 
of the settings need to be changed.   
 

     
 
After the dispersion curve is automatically picked, if Use Median filter is checked, a 
median filter is applied to remove noisy picks.  The median filter is a moving window 
filter sized by the number of samples for the median filter.  For high tolerance of noisy 
picks, a large number would be set for the number of samples.  The default value of 5 is 
suitable for most cases.   
 
The Wavelength limitation defines the wavelength (phase velocity divided by frequency) 
boundaries for picking.  If this option is checked, the limits as defined will be used for 
picking.  The Maximum wavelength limit is calculated by the total offset or array length 
multiplied by the scalar value entered.  The Minimum wavelength limit is calculated by 
the geophone interval multiplied by the scalar value entered.  For active source 
processing, the default value is 2 and for passive source processing the default value is 4.   
 
On the phase velocity-frequency plot, the Maximum wavelength setting controls the slope 
(x/y) of the upper blue line (nearly parallel to the x-axis) and the Minimum wavelength 
controls the slope of the lower blue line (nearly parallel to the y-axis).  To widen the 
limits of picking, that is, the separation between the blue lines, enter a value greater than 
4 for the Maximum wavelength and a value less than 4 for the Minimum wavelength.  
Refer to Section 8.3.1 for more information on the Maximum wavelength and Minimum 
wavelength.  
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The Minimum phase velocity is the lowest phase velocity for which a pick will be made.  
For active source data, depending on whether the units are set to meters or feet, the 
default value is 35 m/s or 150 ft/s, respectively.  For passive source data, it is 70 m/s or 
70 ft/s.  The Maximum phase velocity is the highest phase velocity for which a pick will 
be made.  For all types of data and regardless of units, the default value is 1000 m/s or 
ft/s.   
 
On the phase velocity-frequency plot, a trend of peak amplitudes should be obvious.  If it 
appears that there is only noise below a particular phase velocity on the lower frequency 
end, that velocity should be entered for the Minimum phase velocity to focus the picks to 
the velocity range of the amplitudes associated with the dispersion curve.  Otherwise, 
noise with amplitudes larger than those for signal will be picked.  On the higher 
frequency end, if there is a higher mode(s), the velocity between it and the fundamental 
mode can be entered for the Maximum phase velocity to help prevent the amplitudes 
associated with the higher mode from being picked.  (Even with these limits set, further 
editing of the dispersion curve will likely be required in WaveEq.)   
 
Upon completion of picking, the phase velocity-frequency plot with dispersion curve 
picks (red points) is displayed.   
 

 
 
Picks are automatically made at the mathematical maximum amplitude for each 
frequency.  The x, y-pairs of phase velocity and frequency define the dispersion curve.  
The automatic picks can be manually edited with the mouse by individually clicking on a 
new point or by dragging the mouse over a range of frequencies to set a range of new 
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picks.  Manual picking is facilitated using the Fine color contour  button to switch to 

a color plot and the Waveform amplitude , Horizontal scale , and Vertical 

scale  buttons to optimize the gain and scale.  (These functions are common with 
SeisImager/2D; refer to the SeisImager/2D manual included on the SeisImager CD for 
complete explanation.)  To help identify maxima, as you drag the mouse over the plot the 
amplitude values can be read on the bottom bar ,  where the value 
preceding the colon is the frequency and the value following is the amplitude.       
 
Any picks lying on the y-axis have a phase velocity value of zero and are automatically 
excluded from further analysis.  
 

5.3.3 Surface-Wave Analysis Menu: Show Phase Velocity Curve (1D) 
 
Once the dispersion curve is picked in Pickwin, the picks are held in memory for import 
to WaveEq.  WaveEq is used for detailed editing, inversion, and additional analysis.  
WaveEq can be opened separately and a .pvs file read in, but this single step is the easiest 
way to automatically launch WaveEq and import a dispersion curve just picked in 
Pickwin.     
 
To automatically launch WaveEq and import the dispersion curve from Pickwin, select 
Show phase velocity curve (1D).     
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WaveEq is launched and the dispersion curve plot is displayed.  The unit labels set in 
Pickwin carry over.  Note that in WaveEq, Phase velocity is plotted on the vertical axis 
and Frequency is plotted on the horizontal axis.  Refer to Section 6 for a complete 
explanation of this plot.    
 

 
 

5.3.4 Surface-Wave Analysis Menu: Make CMP Gather Files (2D) 
 
Once a 2D MASW dataset has a file list and its geometry has been assigned, the traces 
can be assembled into CMP cross-correlation gathers.  The steps include calculation of 
cross-correlations between every pair of traces in each shot record, gathering of 
correlation traces by CMPs, and time-domain stacking of correlation traces having equal 
spacing.  The effect is to improve the lateral resolution and accuracy over what is 
normally achieved with conventional 2D MASW.  Refer to Hayashi and Suzuki (2004) 
for a complete explanation of the process.   
 
First, a file list with assigned geometry is opened using the Group (File List) menu, Open 
File List or Make File List and Set Up Geometry as applicable.  Once opened, select 
Make CMP gather files (2D).   
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You will be prompted to make a new (and different) file list.  The new file list is built 
using the existing file list held in memory; the original file list itself is not overwritten.  
For the new file list, the source and receiver locations in the existing file list are replaced 
with CMP locations and CMP cross-correlation gather names.  Click OK. 
 

 
 
Next, set the parameters for organizing the CMPs for the phase velocity calculation.  The 
Bin size is automatically calculated as two times the receiver interval.  In this application, 
a bin is a discrete length that divides the survey line.  Within one bin, traces are sorted 
based on mid-point locations and then stacked to obtain one output trace with increased 
signal-to-noise ratio.  The effect of increasing the Bin size is to reduce the resolution of 
the final Vs cross-section.  The default value for Bin size is suitable for most cases.  The 
First distance and Last distance are taken from the first and last coordinates of the 
receiver spread in the file list.  Click OK.  
 

 
 
CMP cross-correlation traces are calculated and CMP cross-correlation gathers are 
assembled.  A new set of CMP cross-correlation gather SEG-2 files are written to the 
dataset directory with the name cmp_XXXXX.sg2 where the X values are the CMP 
locations.   
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Confirmation that the CMP cross-correlation gathers are calculated and assembled is 
displayed, click OK.   
 

 
 
A series of reports on the process statistics are displayed, click OK to each report.  
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Once calculation of the CMP cross-correlation gathers is complete, a plot of the CMP 
cross-correlation gather geometry is displayed.  Refer to Table 5 in Section 5.1.4.6 for 
explanation of the geometry plot attributes and display functionality.   
 
The horizontal axis, Spacing, is the separation or spatial distribution of the cross-
correlation traces.  The vertical axis, CMPCC Gather No., is the number of the CMP 
cross-correlation gather.   
 
This example shows the highest fold occurs for the center shots which have the most 
traces.  
 

 
 

5.3.5 Surface-Wave Analysis Menu: Phase Velocity-Frequency 
Transformation and Picking (2D) 

 
Once CMP cross-correlation gathers are assembled, select Phase velocity-frequency 
transformation and picking (2D) to transform the time-domain gathers to the frequency 
domain, to calculate the phase velocity for each frequency, and to pick the maximum 
amplitudes which define the dispersion curves.  For 2D MASW, the transformation and 
picking are combined into this one function.   
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The Phase velocity-frequency transformation dialog box (shown on left and Advanced 
menu shown on right) is the same as that explained in Section 5.3.1.  Click OK when 
done.  
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Next, the Min. and Max. Frequency dialog box (shown on left and Advanced menu 
shown on right) is automatically displayed so the amplitude maxima for each curve can 
be automatically picked.  The Min. and Max. Frequency dialog box is the same as that 
explained in Section 5.3.2.  Click OK when done.  
 

   
 
Upon completion of picking, because 2D MASW datasets include many files, all of the 
individual dispersion curves are not shown in Pickwin.  The picks are automatically 
saved as a .pvs file in the dataset directory and held in memory for import to WaveEq.   
 

 
 

5.3.6 Surface-Wave Analysis Menu: Show Phase Velocity Curves (2D) 
 
Once the dispersion curves are picked in Pickwin, the curves are held in memory for 
import to WaveEq.  WaveEq is used for detailed editing, inversion, and additional 
analysis.  WaveEq can be opened separately and a .pvs file read in, but this single step is 
the easiest way to automatically launch WaveEq and import dispersion curves just picked 
in Pickwin.     
 
Select Show phase velocity curves (2D) to automatically launch WaveEq and import the 
dispersion curves from Pickwin. 
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WaveEq is launched and the dispersion curve plot is displayed.  The unit labels set in 
Pickwin carry over.   Note that in WaveEq, Phase velocity is plotted on the vertical axis 
and Frequency is plotted on the horizontal axis.  Refer to Section 6 for a complete 
explanation of this plot.    
 

 
 

5.3.7 Surface-Wave Analysis Menu: 2D Spatial Autocorrelation 
 
For MAM datasets, the function 2D Spatial autocorrelation uses the SPAC method to 
analyze the signal coherency between multiple observation points in a receiver array 
(independent of source location).  Once the signal coherency spectrum is known, phase 
velocity can be determined by finding the best fit between theoretical and observed 
coherency.   
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Once selected, set the geometry of the passive source array in the 2D SPAC dialog box.  
Refer to Section 3.2.1 for explanation of the different array types and Array size.   
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The default dialog box format hides the Advanced menu.  Clicking Advanced menu 
reveals options to define a Manual array, Open array file, Save array file, and to set Data 
storage parameters.   
 

 
 
Data storage allows a particular array geometry to be applied to other data.  Reverse 
cable direction will flip the channel order, Start channel sets the new start channel 
number, and Unused channels allows dead or unused channels to be deleted.  
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If your array does not conform to one of the standard geometries, a Manual array can be 
defined in a simple space-delimited text file where each row is a pair of x- and y-
coordinates.  
 

 
 
Once the Array file is prepared, click on Open array file, highlight the file, and click 
Open. 
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If changes are made to an existing Array file, click on Save array file to revise the file or 
to save a new file with a different name.   
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Once the 2D Spatial autocorrelation process is complete, a signal coherency plot is 
displayed.   
 

 
 
Coherence is the similarity between all possible pairs of geophones, in this case in a 
triangle array with 10 geophones, with an array size of 50 m.  The separation between 
each geophone pair is plotted on the y-axis as Distance and the coherence between each 
of those two traces is plotted as a function of Frequency on the x-axis.   
 
Consider the geophone separation of zero, the coherence is 1 shown by a bar, or 
horizontal line shaded black, across all frequencies.  At a distance of zero, a trace is 
compared with itself and there is 100% similarity or coherence of 1.  Generally, as 
geophone separation increases, coherence decreases.  Coherence also tends to be higher 
at lower frequencies and decreases with higher frequencies.  
 
The shape of a coherency curve by nature is a Cosine function with 1D arrays and a 
Bessel function (decaying Cosine function) with 2D arrays (shown above).  The 
coherency curve for each separation is well shaped (calculated from what is considered 
an ideal dataset).  Compare this with the coherency plot for a 60-foot L11 array that 
shows poor coherence for all separations greater than zero (shown below).     
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In the field, coherence is a quick calculation and can be readily performed to confirm that 
MAM datasets will yield good results. 
 

5.4 Option Menu 
 
The Options menu includes program controls and display settings.  
 

 
 

5.4.1 Option Menu: Dimension Size 
 
To view or change the program data input allowances, select Dimension size.  
 
Present size reflects the current dimensions for Maximum samples and Maximum traces 
and Maximum shows the largest possible dimensions.  Typically it is unnecessary to 
change the number of Maximum samples.  It can be useful to change the number of 
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Maximum traces to 64 from 128 to speed up processing, but this will also reduce the 
resolution of the phase velocity plot.  The number of Maximum traces may need be 
increased if you are processing a passive source dataset with a large number of traces, for 
example, greater than 48.   
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To change the dimensions, enter the new value(s), check Change dimension size, and 
click OK. 
 

 
 
Click OK and restart the program.   
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If a very large value is entered, such as 1024 for Maximum traces, a warning message 
will appear before you are allowed to restart the program.  It is recommended that you do 
not proceed; select No and reduce the dimensions.   
 

 
 
If you proceed and indeed the PC has insufficient memory, the program will no longer be 
able to open.  To lower the values and recover the program, open the Dimension size 
dialog box directly by pressing the Shift key while double-clicking the program icon.   
 
The wizard automatically defaults to standard dimensions to run efficiently.  To use non-
standard dimensions, you will need to process data manually.    
 
If a program upgrade is purchased, the new registration password can be directly entered 
in the Dimension size dialog box in the Password for upgrade field; however, it is 
strongly recommended to upgrade via the SeisImager Registration program instead. 
 

5.4.2 Option Menu: Meters and m/sec and Feet and ft/sec 
 
Select the desired unit labels by choosing meters and m/sec or feet and ft/sec.  The setting 
is reflected in the display labels, dialog box labels, and default values where applicable. 
 

5.4.3 Option Menu: English 
 
The program language can be converted between English and Japanese.  To convert to 
Japanese, uncheck English.  Obviously, this is not recommended unless you want to use 
the software in Japanese and have the necessary version of Windows.  If symbols appear 
in various places, it is likely that the language is not set to English and Windows is 
unable to render the program in Japanese.   
 

5.4.4 Option Menu: Menu Type 
 
Menu type of Simple pertains to the menu structure of SeisImager/2D.   
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5.5 Button Bar Functions 
 
The button bar functions essential or uniquely used for surface wave data processing are 
covered in this section.  For a complete description of the button bar functions common 
to SeisImager/SW and SeisImager/2D, please refer the separate SeisImager/2D manual 
included on the SeisImager CD.    
 

5.5.1 Button Bar: Undo  and Redo  
 
After the phase velocity-frequency transformation has been calculated for a given 
waveform file or dataset, click on the Undo button to cancel the phase velocity plot.     
 

 
 
For a single file (shot or CMP cross-correlation gather), after clicking the Undo button, 
the waveform file will appear.   
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For a passive source dataset, after clicking the Undo button, the coherency plot will 
appear.  
 

 
 
To return to the phase velocity plot in either case, click the Redo button.  Note that the 
Undo and Redo functions run only one cycle, so if Undo is clicked again, the waveform 
and coherency files will not be found and it will necessary to restart the program.   
 
The Undo button is very useful when the optimal analysis parameters are not yet known 
and iterative testing is required.  
 

5.5.2 Button Bar: Normalize  
 
When traces are normalized, the maximum amplitude of each trace will be equalized.  
Lower amplitude traces (those farther from the source) will be “turned up” so that their 
maximum amplitude is equal to that of higher-amplitude traces.  This has the effect of 
equalizing the appearance of all the traces across the record and allows viewing of the 
active source surface wave train.   
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With Normalize off, the traces distant from the source are not visible.   
 

 
 
With Normalize on, traces at all distances are visible.  
 

  
 
With passive source surface wave data, to observe trace-to-trace variations, Normalize 
should be turned off.  With Normalize on, note the appearance of traces 4 through 7.  
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With Normalize off, traces 4 through 7 are slightly higher amplitude.  
 

 
 

5.5.3 Button Bar: Show Previous Waveform File  and Show Next 
Waveform File  

 
When more than one waveform file (shot or CMP cross-correlation gather) is input, the 
files can be scrolled through using the Show previous waveform file and Show next 
waveform file buttons.   
 

5.5.4 Button Bar: Coarse Contour Color  
 
The phase velocity-frequency plot display is enhanced with color gradients.  To apply a 
coarse contour color scale, click the Coarse contour color button.   
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5.5.5 Button Bar: Fine Contour Color  
 
The phase velocity-frequency plot display is enhanced with color gradients.  To apply a 
fine contour color scale, click the Fine contour color button.  The fine setting takes 
slightly longer to paint on the screen, but gives a smoother gradient compared to Coarse 
contour color.   
 

 
 

5.5.6 Button Bar: Wiggle Line  and Shaded Black  
 
The default trace display for the phase velocity-frequency plot is a black line with the 
positive side shaded corresponding to the Wiggle line and Shaded black buttons, 
respectively.    
 

 
 

5.5.7 Button Bar: Show Waveforms  and Show Geometry  
 
After the geometry has been calculated and applied for a given dataset, the Show 
waveforms button and the Show geometry button are activated and allow toggling 
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between the two views.  In the Show geometry view, the Show previous waveform file 
and Show next waveform file buttons allow selection of a shot or CMP cross-correlation 
gather’s geometry.   
 

 
 
Click the Show waveforms button to display the gather associated with the selected 
geometry. 
 

 
 

5.5.8 Button Bar: Frequency Domain  
 
The Frequency domain button transforms a time-domain waveform file to the frequency 
domain.  Clicking on the Frequency domain button will change the view from the 
waveform record to a plot of the frequency content or spectrum for each trace.  It will be 

necessary to press the right Horizontal scale  button or the right arrow key to expand 
the frequency scale and zoom in on the lower end.     
 
Unlike most active source data, it is usually difficult to evaluate the quality of passive 
source data by viewing the waveform record in the time domain.  Similar frequency 
content from trace-to-trace indicates higher-quality data.   
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Uneven frequency content from trace-to-trace indicates lower-quality data.  
 

 
 

5.5.9 Button Bar: Time Domain  
 
The Time Domain button toggles out of the Frequency domain view.   
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6 – The WaveEq Module Functions 
 

6.1 File Menu  
 
The File menu includes functions for opening WaveEq result files, importing and 
exporting various files, and printing.  
 

 
 
The Advanced options are not active at this time.  
 

6.1.1 File Menu: Open 1D Phase Velocity Curve File (.rst) 
 
To open a single dispersion curve or Vs curve previously saved with the extension .rst, 
select Open 1D phase velocity curve file (.rst). 
 
Highlight the file and click Open.   
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6.1.2 File Menu: Save 1D Phase Velocity Curve File (.rst) 
 
To save a single dispersion curve or Vs curve, select Save 1D phase velocity curve file 
(.rst).  A curve file can be saved at any time in the processing flow and will reflect the 
extent of results at the time of save.   
 
Assign a file name with the extension .rst and click Save.  
 

 
 

6.1.3 File Menu: Open 2D Phase Velocity Curve File (.pvs)  
 
To open a set of dispersion curves previously saved with the extension .pvs, select Open 
2D Phase Velocity Curve File (.pvs).   
 
Highlight the file and click Open.   
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6.1.4 File Menu: Save 2D Phase Velocity Curve File (.pvs)  
 
To save a set of dispersion curves, select Save 2D Phase Velocity Curve File (.pvs).  A 
curve file can be saved at any time in the processing flow and will reflect the extent of 
results at the time of save. 
 
Assign a file name with the extension .pvs and click Save.  
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6.1.5 File Menu: Print , Print Preview, and Page Set-up 
 

To print the current WaveEq display, choose Print (P), press Ctrl-P, or click the Print  
button.   
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To preview the WaveEq display before printing, select Print preview (V).   
 

 
   
To set up a page for printing, select Page set up(R).  
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6.1.6 File Menu: Import Elevation Data File  
 
Survey line elevations can be imported and plotted on 2D MASW initial and final cross-
sections.  Note that elevations are not incorporated into the data analysis, they are only 
used for plotting.  For this reason, it is recommended that surveys be conducted on 
generally flat ground.  Some variation in elevation can be tolerated and would be 
averaged, especially for the passive source surveys, but flat ground is best.   
 
Create an elevation file as a simple space-delimited text file where each row is a pair of 
x- and z-coordinates.  At a minimum, two coordinates are required; the values in between 
will be interpolated.  The coordinates need not exactly match the geophone and shot 
locations, and can extend off the ends of the survey line.   
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To open an elevation file, select Import elevation data file, highlight the file and click 
Open.     
 

 
 
If not imported here, elevation data can also be imported in GeoPlot by selecting the File 
menu, Open topography data file.   
 

6.1.7 File Menu: Save 1D Analysis Result in Tabular Form (.txt) 
 
To save the final results of a 1D MASW or MAM dataset analysis in tabular form, select 
Save 1D analysis result in tabular form (.txt).   
 
Assign a file name with the extension .txt and click Save.  
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The file is a simple text file with Depth, S-wave velocity, P-wave velocity, Density, and N 
(or blow counts).  Refer to Section 6.5.4 for more information on the relationships used 
for calculating the equivalent P-wave velocity, Density, and N. 
 

 
 

6.2 Edit Menu 
 
The Edit menu contains functions for making and reversing edits and copying graphical 
displays to the clipboard.  
 

 
 

6.2.1 Edit Menu: Undo  
 
The Undo function can be used to reverse the selection or repositioning of a point on a 

dispersion curve using the Select dispersion curve  or Correct dispersion curve  
buttons, respectively.  Undo does not apply to all functions.  
 

6.2.2 Edit Menu: Delete 
 
The Delete function or Delete key becomes active when a point on the dispersion curve 

has been selected using the Select dispersion curve  button.  To delete a point on a 
dispersion curve, activate editing with the Select dispersion curve button, then use the 
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mouse to select the point(s) on the dispersion curve to be deleted.  The selected points are 
highlighted in red.  Select Delete or press the Delete key to remove the selected points.  
 

6.2.3 Edit Menu: Copy to Clipboard  
 
To copy the current display to the clipboard for pasting in Microsoft Word or other 
program, select Copy to clipboard.   
 

6.3 View Menu 
 
The View menu includes functions to configure scales, alter displays, and overlay or 
import other types of data.   
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6.3.1 View Menu: Axis Configuration 
 
To configure the axis scales on a dispersion curve(s) or velocity curve(s) plot, select Axis 
configuration.  The Minimum values for the X-axis and Y-axis are fixed at zero.  The 
Maximum values set the outer limits.  The Interval is the size of the sub-divisions.   
 

 
 

6.3.2 View Menu: Dispersion Curves 
 
The Dispersion curves dialog box controls how dispersion curves are displayed.  The Plot 
curve options allow Single, Next curves, or All curves to be displayed.  These settings 

correspond to the Show one dispersion curve , Show next dispersion curve , and 

Show all dispersion curves  buttons, respectively.   
 

 
 
Single and the Show one dispersion curve button display one dispersion curve in red.  
Next curves and the Show next dispersion curve button display one curve in red with the 
down-line adjacent curve in green and the up-line adjacent curve in blue for a total of 
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three curves.  All curves and the Show all dispersion curves button display all curves 
starting with red, blue, green, and with the rest unique in color but undefined.  They are 
undefined since with all curves displayed, it the overall trend that is meant to be 
discerned, not the individual curves.   
 
Shift allows the curves to be bulk shifted by the value entered.   
 
Show quality checked (the default) displays a dashed quality curve with each dispersion 
curve.  The quality curve is a relative indicator of the quality of the data points that define 
a dispersion curve and corresponds with data point circle size as shown below.  If all data 
points are high quality (large circles), the curve is predominantly flat.  However, due to 
variation in the signal-to-noise ratio, the quality curve will have peaks and valleys 
correlating with the relatively higher and lower quality data points (smaller circles), 
respectively.     
 

 
 
For display of a Single, Next curves, or All curves, the quality curve has the same colors 
as the associated dispersion curves.  Refer to Sections 6.4.4 and 6.4.5 for more 
information on quality.      
 
Show ellipticity (H/V), allows the horizontal over vertical amplitude ratio for three-
component passive source data to be plotted.   
 

Quality curve 
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6.3.3 View Menu: Frequency/Period  
 

The function Frequency/period and the Frequency/period  button allow toggling the 
view of the dispersion curve between frequency (cycles per second) and period (seconds), 
the inverse of frequency.  
 

   
 
It may be more intuitive to think in terms of seconds, which directly relates to the natural 
period of buildings, etc.  
 

6.3.4 View Menu: Show One , Three , and All  Dispersion Curves 
 
Show one dispersion curve, Show three dispersion curves, and Show all dispersion curves 
are the menu items associated with the button bar functions described in Section 6.3.2.  
 

6.3.5 View Menu: Show P-Velocity and Show Converted N-Value 
 
To overlay calculated P-wave velocities (Vp) and N-values on a Vs curve, select Show P-
velocity and Show converted N-value.  A green curve is displayed for Vp and the 
horizontal axis will include a second scale corresponding to the Vp values.  A red curve is 
displayed for N-values and the horizontal axis will include a third scale corresponding to 
the N-values. 
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The Vp values and N-values are calculated using the equations defined in the Velocity 
model menu, Advanced options, Vp and Vs relationship and N and Vs relationship.  Refer 
to Section 6.5.4 for more information.  
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6.3.6 View Menu: Open N-Value File and Show N-Value File 
 
Measured N-values can be used to define the initial Vs model used for inversion.  The 
values are formatted in a space- or tab-delimited text file with a depth and corresponding 
N-value in each row.  The file can have the extension .n or .txt.   
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Once the file is prepared, select Open N-value file, highlight the file, and click Open.  If it 
has the extension .txt, you will need to choose All files under Files of type so it is shown 
in the list.   
 

 
 
The N-values are stored in memory until the initial Vs model is created, at which time the 
initial model will be displayed with the N-values.  When an N-value file has been 
opened, by default the initial model will be based on the N-values.  Refer to Section 6.6.1 
for more information. 
 

 
To toggle between viewing the Vs curve with and without N-values, select Show N-value.   
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6.3.7 View Menu: Open PS Result File and Show PS Result 
 
Once a velocity model exists, measured Vp and Vs values can be input for comparison or 
to refine the model.  The values need to be formatted in a space- or tab-delimited text file 
with a depth and corresponding Vp and Vs values in each row.  The file can have any 
extension. 
 

 
 
Once the file is prepared, select Open PS result file, highlight the file, and click Open.   
 

 
 
To toggle between viewing the model with and without the measured Vp and Vs data, 
select Show PS result.   
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6.3.8 View Menu: Show AVS for IBC 
 
To calculate the average Vs as defined by the 2000 and 2003 International Building Code 
(IBC) in Section 1615.1.5, Equations 16-22 and 16-44, respectively, select Show AVS for 
IBC.  The calculated average Vs is shown at the bottom of the velocity model in the 
applicable units.   
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The result is saved to a text file with the name AVS.txt in the dataset directory.  The first 
row reports the applicable Units and maximum Depth used for the calculation.  Following 
are six columns of data, one row for each layer.  The columns from left to right are: layer 
number (No.), shear-wave velocity (Vs), slowness (sl) (the inverse of velocity), layer 
thickness (d), layer thickness divided by Vs (Tot. Vs), and total thickness (Tot. d).  The 
last row reports the IBC Vs100/UBC Vs30 value.  In this example, the second layer (No. 
1) is 3.132-feet thick (d) with a layer thickness-to-Vs ratio of 13.024 seconds (Tot. Vs), 
and the total depth at the base of this layer is 7.692 feet (Tot. d). 
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The average N as defined by the 2000 and 2003 International Building Code (IBC) in 
Section 1615.1.5, Equations 16-23 and 16-45, respectively, will also be calculated if you 
have opened an N-value file.   
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The result is saved to a text file with the name AN.txt in the dataset directory.  There are 
five columns of data, one row for each layer.  The columns from left to right are: layer 
number (No.), the N-value (N), layer thickness (d), total thickness (Tot. d), and layer 
thickness divided by the N-value (Tot. d/n).  The last row reports the IBC N100/UBC 
N30 value.  In this example, the second layer (No. 1) is 0.2-meters thick (d) with a layer 
thickness-to-N ratio of 0.1 (Tot. d/n), and the total depth at the base of this layer is 0.4 
meters (Tot. d). 
 

 
 
If the average Vs and N are to be calculated, it is recommend that there be reliable 
information to 30 m or 100 ft.  Although the Vs model may extend to 30 m or 100 ft 
depth, the recorded surface waves may not have actually sampled to that depth.  Refer to 
Section 6.3.9 on how to estimate the depth of penetration.     
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6.3.9 View Menu: Show Water Table Depth, Show Layer Boundary , 

Show Apparent Velocity Model (VR) , Show Effective Depth (VR 
Max), and Show Vs and Depth 

 
To show the depth of the water table on a velocity model, select Show water table depth.  
A blue line with the standard water table symbol will appear as shown below.  If there is 
no water table depth established, the line will plot at a depth of zero.  The depth of the 
water table is set in a separate menu explained in Section 6.5.3.  
 

Selecting Show layer boundary or clicking the Correct velocity model  button will 
outline the layers in the profile with horizontal black lines.  Using the mouse, the vertical 
edge of any of the layers can be dragged to a new position to modify the Vs curve.  In the 
dispersion curve view, the dispersion curve calculated for the altered model can be 

viewed by clicking on the Comparison  button.  The Vs curve can be manually fitted 
to the observed data in this manner.  
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Selecting Show apparent velocity model (VR) or clicking the Apparent velocity model  
button will plot in green points the one-third-wavelength approximation.  Using each set 
of dispersion curve points (phase velocity, frequency), the wavelength is calculated 
(phase velocity divided by frequency) and then multiplied by one-third from the 
empirically determined estimate of depth of penetration.  At that calculated depth, the 
associated phase velocity is plotted.  This approximation is the best indicator of actual 
depth range of penetration.   
 
Show effective depth (VR max) shades the profile light gray from the deepest green point 
downward. This setting is on by default to call attention to the limits of the data.  
 
Show Vs and depth overlays the layer information used to calculate the IBC Vs100/UBC 
Vs30 value.  
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6.3.10 View Menu: Advanced Options: Show Regression Line 
 

 
 
Show regression line is not active at this time.  
 

6.4 Dispersion Curves Menu 
 
The Dispersion curves menu allows various editing of dispersion curves, including data 
point deletion and curve smoothing.  Editing can be particularly important to remove 
outlying data points, noisy jitter, and higher modes, etc.  Relatively small-scale anomalies 
on dispersion curves cannot be resolved by the surface wave method and they can cause 
instabilities in the inversion and/or unrealistic aspects in the final results.  The overall 
trend of the dispersion curve(s) should be preserved in the editing process.   
 

 
 

6.4.1 Dispersion Curves Menu: Smoothing (Individual Curves) 
 
To smooth one dispersion curve, select Smoothing (individual curves).  The process 
recalculates one individual dispersion curve using the average of three adjacent data 
points in the direction of frequency.  The original dispersion curve (shown on left) is 
converted to a smoother curve with less noisy jitter and the data points evenly distributed 
(shown on right). 
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When applied to a 2D dataset with multiple dispersion curves, the process acts on each 
individual curve.  All the original curves (shown on left) are converted to smoother 
curves with less noisy jitter and the data points evenly distributed (shown on right). 
 

  
 
Because Smoothing (individual curves) is applied in the direction of frequency, you may 
find for some 2D datasets, that a smoothing function applied from curve to curve yields 
preferable results.  
 

6.4.2 Dispersion Curves Menu: Smoothing (2D Median Filter) 
 
To smooth between dispersion curves in a 2D dataset, select Smoothing (2D median 
filter).  The process recalculates the set of dispersion curves using the median of five 
adjacent data points from curve to curve.  The original dispersion curves (shown on left) 
are converted to smoother curves with fewer outlying data points and the relative 
difference between individual curves preserved (shown on right).   
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6.4.3 Dispersion Curves Menu: Delete Picks by Value, Delete Picks 
Outside of Gate, and Delete Picks Between Gate 

 
To set the minimum and maximum gate frequencies by entering specific values, select 
Delete picks by value.     
 

 
 
As an alternative, the frequency range can be set visually.  Select Delete picks outside of 
gate and two gates will appear on the dispersion curve plot (shown on left).  If needed, 
press the Esc key to exit.  
 
The color red indicates which gate is active and the color green indicates which gate is 
inactive.  Use the right arrow key to move the red gate to the new minimum frequency 
(shown on right).   
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After the first gate is positioned, press the Enter key and the next gate will become active.  
Use the left arrow key to move the gate to the new maximum frequency (shown on left).  
Press the Enter key when done and the trimmed dispersion curve is displayed (shown on 
right).  
 

 
 
 
In setting the gates, exclude only the points that are poor-quality or spurious.  Commonly, 
on the low-frequency end, the phase velocity will start to decrease and the dispersion 
curve will slope downward (when phase velocity is plotted on the y-axis).  This decrease 
in phase velocity is usually an artifact of difficult picking because the peak amplitudes at 
low frequencies become less distinct.   
 
To determine where to set the new maximum frequency on the high-frequency end, the 
quality line can be used to assess where the quality starts to decrease (usually due to weak 
amplitudes at higher frequencies).  In addition to quality, if the phase velocity starts to 
increase that is likely related to higher mode energy and those points should be deleted.  
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To remove points within a gate, select Delete picks between gate.  The gates are 
positioned as described for Delete picks outside of gate, except that the inactive gate is 
indicated by the color teal blue.  Delete picks between gate is useful for deleting higher 
modes.  The editing sequence progresses below from left to right. 
 

 
 

 
 

6.4.4 Dispersion Curves Menu: Delete Low Quality Data and Delete Higher 
Mode 

 
To automatically delete low quality picks, select Delete low quality data.  Low quality 
tolerance is set in the Advanced options menu, Setup low quality limit.  Refer to Section 
6.4.5 on how to adjust the quality tolerance.     
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Upon selection, all the points that fall below the quality limit will be deleted (shown on 

right).  To reverse the changes, click the Undo  button.  
 
 

       
 
 
If higher mode picks appear in the dispersion curve (shown on left), select Delete higher 
mode to automatically delete the picks (shown on right).  Higher mode tolerance is set in 
the Advanced options menu, Setup higher mode selection.  Refer to Section 6.4.5 on how 
to adjust the higher mode tolerance. 
 
 

       
 

Fundamental 
mode 

Higher 
mode 

Low quality 
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6.4.5 Dispersion Curves Menu: Advanced Options: Smoothing (Multiple 
Curves), Resampling (Every Other), Setup Low Quality Limit, and 
Setup Higher Mode Selection  

 

 
 
To smooth between dispersion curves in a 2D dataset, select Smoothing (multiple curves).  
The process is similar to Smoothing (2D median filter) (Section 6.4.2) except that the 
average of five adjacent data points is used instead of the median.  The original 
dispersion curves (shown on left) are converted to smoother curves with fewer outlying 
data points but the relative difference between the individual curves is minimized (shown 
on right).     
 

  
 
The function Resampling (every other) is used to speed up processing by decimating the 
dataset (removes every other sample).   
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Setup low quality limit allows the filter limit that is used when the function Delete low 
quality data is selected to be set.  Quality is a relative measurement normalized against 
the highest signal for each dataset.  Quality is indicated by the quality line and the data 
point circle size on the dispersion curve plot.  The largest circle size possible is equal to 
1.0 and the smallest circle size possible is a dot, which equals zero.  The default Quality 
limit value is 0.7, meaning that where the quality line goes below 70% of the relative 
scale, the associated data points will be deleted.  The default Quality limit value is 
suitable for most cases.   
 

 
 
Setup higher mode selection allows the filter limits used when the function Delete higher 
mode is selected to be set.  The default Fundamental mode limit value is 1.2, meaning 
that where the value of any data point is 20% more than adjacent values, those points are 
deleted.  This value can be set between 1.0 and 5.0.  The Higher mode maximum depth is 
the depth as determined from the one-third-wavelength approximation below which the 
associated data points will not be allowed.   
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6.5 Velocity Model Menu 
 
The Velocity model menu allows editing and setting of parameters for calculation of 
velocity models.  In addition, it includes display controls and some analyses for 
interpretation.  
 

 
 

6.5.1 Velocity Model Menu: Horizontal Smoothing (2D) and Vertical 
Smoothing 

 
To horizontally smooth between individual velocity models in a 2D dataset, select 
Horizontal smoothing (2D).  The process recalculates the set of velocity models using the 
average of three adjacent data points from model to model.  Any sharp lateral velocity 
gradients between the original velocity models are smoothed.  
 
To vertically smooth individual velocity models in a 2D dataset, select Vertical 
smoothing.  The process recalculates individual velocity models using the average of 
three adjacent data points in the direction of depth.  Any sharp vertical velocity gradients 
in the original velocity model are smoothed. 
 

6.5.2 Velocity Model Menu: Show Velocity Model , Show Three Models 

, Show All Models   
 
Once a velocity model exists, Show velocity model, Show three models, and Show all 
models, are used to control the display.  These settings correspond to the Show velocity 

model , Show three models , and Show all models  buttons, respectively.   
 
Show velocity model and the associated button display one velocity model in black with 
grey shading.  Show three models and the associated button display one model in red with 
the down-line adjacent model in green and the up-line adjacent model in blue for a total 
of three models.  Show all models and the associated button display all models starting 
with red, blue, green, and with the rest of the colors unique but undefined.  They are 
undefined since with all models displayed, it the overall trend that is meant to be 
discerned, not the individual models.   



 

SeisImager/SW Manual  6 – The WaveEq Module Functions 
Version 3.0, October 2009  Page 255 of 314 

The Show velocity model button is useful for toggling from the dispersion curve to 
velocity model view.  
 

6.5.3 Velocity Model Menu: Setup Water Table 
 
Once a velocity model exists, the depth of the water table can be set with Setup water 
table.  The default Water table value is zero; enter the applicable value and click OK.  
 

 
 
The model layer boundaries will be adjusted to place a boundary at the water table depth.  
Click Yes to confirm the change.     
 

 
 
The water table is now set.  Select the View menu, Show water table depth to display the 
water table as a blue line with the standard water table symbol on the velocity model.   
 

6.5.4 Velocity Model Menu: Advanced Options: Vp and Vs Relationship and 
N and Vs Relationship 

 

 
 
The Vp and Vs relationship and N and Vs relationship dialog boxes allow the equations 
used for calculating Vp from Vs and N from Vs to be customized.   
 
To modify the default equations for calculating Vp from Vs, select Vp and Vs relationship 
(dialog box with metric units selected shown on top, with English units selected shown 
on bottom).  An equation may be defined for above and below the water table, with the 
water table depth set in the Velocity model menu, Setup water table dialog box (Section 
6.5.3).  The default equation for above the water table is simply two times Vs.  The 
default equation for below the water table is from Kitsunezaki (1990).  The effect of Vp 
on phase velocity is typically minimal; these relationships are suitable for most models.   
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Relationships can also be manually set by choosing Manual and inputting Vp values 
through the View menu, Open PS result file.   
 



 

SeisImager/SW Manual  6 – The WaveEq Module Functions 
Version 3.0, October 2009  Page 257 of 314 

To modify the default equations for calculating N from Vs, select N and Vs relationship 
(dialog box with metric units selected shown on top, with English units selected shown 
on bottom).  The default equations are from Imai and Tonouchi (1982).  This relationship 
is suitable for most models. 
 

 
 

 
 
Where applicable, the equation used for calculating density is as follows from Ludwig et 
al. (1970). 
 

ρ = 1.2475 + 0.399Vp – 0.026Vp
2 

 
To revert back to the default values, click Default.  
 

6.5.5 Velocity Model Menu: Advanced Options: Interpretation, Show UBC 
or IBC Site Classifications and Seismic Interpretation 

 

 
 
In addition to calculating the average Vs as described in Section 6.3.8, the associated site 
class can also be determined by selecting Show UBC or IBC site classifications.  [The 
UBC is the Uniform Building Code (1997) which uses metric units.  The IBC (2000, 
2003) is based on the UBC but uses English units.  Refer to Building Seismic Safety 
Council (1997), International Code Council (2000, 2003), and Underwood and Hayashi 
(2005) for more information.] 
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Once Show UBC or IBC site classifications is selected, the average Vs is calculated and 
displayed with the associated site class (Table 6).   
 

 
 

Table 6.  UBC/IBC Site Classifications 
 
Site class 

 
Soil type 

 
UBC Vs30 

 
IBC Vs100 
 

 
Class A 
 

 
hard rock 

 
Vs30 > 1,500 m/s 

 
Vs100 > 5,000 ft/s 
 

Class B rock 760 < Vs30 ≤ 1500 m/s 2,500 < Vs100 ≤ 5,000 ft/s 
 

Class C very dense soil,  
soft rock 
 

360 < Vs30 ≤ 760 m/s 1,200 < Vs100 ≤ 2,500 ft/s 

Class D stiff soil 180 < Vs30 ≤ 360 m/s 600 < Vs100 ≤ 1,200 ft/s 
 

Class E soft soil Vs30 < 180 m/s Vs100 < 600 ft/s 
 

Class F soils requiring site 
specific evaluation 
 

Non-applicable Non-applicable 

 
Calculating traveltime and Seismic interpretation are not active at this time.   
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6.5.6 Velocity Model Menu: Advanced Options: Truncate Min and Max 
Velocity and Horizontal Average (2D)  

 

 
 
To set a minimum and maximum velocity for a given velocity model, select Truncate 
min. and max. velocity.  The Min. velocity and Max. velocity reported are the actual 
minimum and maximum velocities for the current model.  (Although m or ft is shown as 
the unit label, the values are actually velocities with the unit label of m/s or ft/s, 
respectively.)  
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To set new boundaries, enter new values as desired and click OK.  Note that the value 
entered for Max. velocity will be retained for the WaveEq session unless changed again 
or a new WaveEq instance is opened.   
 

 
 

 
 
Typically, Truncate min. and max. velocity is used when building an initial model from 
scratch.   
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To make a cross-sectional velocity model uniform in the direction of distance, select 
Horizontal average (2D).  The process recalculates the velocity model using the average 
value at each depth.  The original model (shown on left) with horizontal variation is 
converted to a simplified, horizontally uniform model (shown on right).   
 

 
 

6.6 MASW (1D) Menu 
 
The MASW (1D) menu primarily includes functions for calculating an initial model for a 
1D dataset and running the inversion to find the best fit of the initial model with the 
observed data.  Other modeling functions are also included.  Although the term MASW 
refers to active source surveys, the same functions apply for analysis of MAM datasets.  
 

 
 
The Advanced options are not available at this time.  
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6.6.1 MASW (1D) Menu: Initial Model 
 
The initial Vs model is the starting point for the inversion.  To generate an initial model 
for a single dispersion curve, select Initial model.  The Initial model for inversion dialog 
box shows only the Depth and Number of layers by default.  In most cases, only the 
maximum Depth of the model needs to be entered and the default value of 15 for the 
Number of layers is suitable.     
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Clicking on Advanced menu reveals the rest of the parameters with default values.  
Typically, none of these settings need to be changed.  
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Initial models are calculated Based on depth conversion result by default.  This method 
uses 1.1 times the phase velocity for an estimate of Vs and the one-third-wavelength 
approximation for an estimate of depth.  The Minimum (phase) velocity and Maximum 
(phase) velocity are automatically assigned corresponding directly to the low and high 
values observed on the dispersion curve.  The Maximum velocity is automatically 
assigned to the deepest layer. 
 

 
 
Alternatively, initial models can be constructed using a Linear model, Homogeneous 
model, or using N-values via Use N-value.  A Linear model (shown on left) is constructed 
following a straight line starting at the Minimum velocity and ending at approximately the 
Maximum velocity (the model may not extend to exactly the Maximum velocity depending 
on the number and configuration of layers).  A Homogeneous model (shown on right) has 
no velocity variation with depth; the Minimum and Maximum velocity have the same 

value.  The Show apparent velocity model  button overlay provides a visual 
comparison of the Based on depth conversion result model with the Linear model and the 
Homogeneous model.  
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To base the initial model on N-values, select Use N-value.  The model Depth will be 
automatically set to the deepest N-value.  Note that the N-value file must already be open 
through the View menu, Open N-value file.  If it is not open, you will be notified.  Click 
OK, open the N-value file, and then come back to Initial model.  
 

 
 
Layer thickness applies to all models.  Selecting Identical sets all layers equal in 
thickness.  By default, the layer thickness is set to Variable, and thus, layers increase with 
depth.  The Layer thickness gradient controls how the thickness increases with depth.  A 
value of 1 means there is no gradient and layer thicknesses are identical.  A value less 
than 1 thickens the layers with depth and as the value decreases, the gradient of 
thickening increases.  The default value of 0.5 is suitable for most models.   
 
The Bottom layer multiplier controls the thickness of the bottom layer relative to 
overlying layers.  The thickness of the bottom layer, or layer just above the model half-
space, can have a large impact on the calculated dispersion curve.  Setting it thicker than 
the overlying layers stabilizes the inversion, hence the Variable default setting.  After the 
Layer thickness gradient is applied, the thickness of the bottom layer is multiplied by the 
multiplier value.  The multiplier default value is 3 and is suitable for most models.   
 
To set layer thickness based on N-values select Based on N-value.  As noted above, the 
N-value file must already be open through the View menu, Open N-value file.   
 
To disallow velocity inversions in the final Vs model, check Use assumption that velocity 
is increasing with depth.  It is common to see small velocity inversions near the surface 
(especially at paved sites) and at the water table due to an increase in pore pressure, and 
thus, is it suggested to leave this setting unchecked.  This setting can be useful when you 
detect higher modes and want to suppress their influence on the final result.   
 
For initial cross-sectional models, Apply horizontal interpolation is checked by default to 
allow construction by interpolation between a series of velocity curves.   
 
The Initial model for inversion dialog box settings revert back to the default values each 
time the dialog box is opened.   
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6.6.2 MASW (1D) Menu: Inversion and Inversion with N 
 
6.6.2.1 MASW (1D) Menu: Inversion 
 
To calculate the Vs curve that best matches the observed data, select Inversion.  The 
mathematical process is based on the Least-Squares Method and simply stated, iteratively 
modifies the initial model to minimize the difference from the observed data.  After 
running through a number of iterations, the modified initial model is output as the final 
model.  Refer to Hayashi (2003) for a complete explanation.  
 
Upon selecting Inversion, the Least Squares Method dialog box shows the Iteration 
parameter with a default value of 5.   
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Iteration is the number of times the initial model will be compared and modified to 
converge on the best match with the observed data.  In between iterations, the improved 
model is used as the new starting point so the error or mismatch should decrease.  The 
iteration concept is conveyed by the flowchart below.  
 

 
 
The default Iteration value of 10 is suitable for most cases.  Increasing the Iteration value 
may occasionally be necessary; this will allow the process additional attempts to 
minimize the mismatch between the initial model and the observed data.    
 
Upon clicking OK, the inversion process begins and the error in velocity (m/s or ft/s) and 
percent (%) is displayed.  The error should decrease after each iteration and the final error 
should be less than about 5% but will depend on the dataset.   
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Once the inversion is complete, click OK.  
 

 
 
The final error value is saved to a file called RMSE.txt in the dataset directory.  
 

 
 
If the error ever increases during the inversion, the process will terminate.  The initial 
model settings, inversion parameters, and units selected in the Option menu should be 
checked and corrected if necessary before running the process again.   
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Clicking on Advanced menu reveals the rest of the parameters with default values.  
Typically, none of these settings need to be changed. 
 

 
 
The Alpha and Beta settings optimize the matrix inversion through deceleration and 
acceleration, respectively.  An Alpha multiplier of the maximum logical value of 1 
provides the least stabilization.  Values less than 1 provide increasing stability but are 
more computationally intensive, and thus, cause the process to run more slowly.  A value 
of zero cancels this factor.    
 
Alpha is so named because it is used in the first iteration to stabilize the inversion.  As the 
process stabilizes, Alpha is multiplied by Beta to increase the inversion speed.  A Beta 
value of 1 causes no acceleration; values greater than 1 are used for acceleration.   
 
E is a dumping parameter also with the effect of stabilization.  E would be increased to 
increase stability.   
 
Regularization is a type of matrix smoothing, working to control large velocity gradients 
across each depth layer.  For a higher degree of smoothing and lower tolerance of lateral 
velocity gradients, a lower value would be used.  A value of 1 equals no smoothing.  All 
of the layers would be artificially similar if excessive smoothing was applied.   
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The values for Alpha, Beta, e, and Regularization rarely need to be changed.  Illogical 
values for these parameters will cause erroneous results.   
 
Saying Yes to Constraint will use the indicated Minimum (phase) velocity and Maximum 
(phase) velocity to limit the lower and upper bounds of the inversion.  This can be useful 
if you have accurate knowledge of velocity, otherwise the default values are 
automatically assigned corresponding directly to the low and high values observed on the 
dispersion curve. 
 
Weighting for quality incorporates dispersion curve pick quality into the inversion.  
Robust estimation puts less weight on data with large error.  Keep first layer velocity 
prevents the velocity of the shallowest layer from changing.  This is useful if the first 
layer has a high known velocity, like pavement.   
 
If Save matrix information is checked, the Jacobian matrix from each iteration is saved to 
a file called Matrix.txt in the dataset directory.  
 
Note that the Least Squares Method dialog box parameters revert back to the default 
values each time WaveEq is opened.   
 
6.6.2.2 MASW (1D) Menu: Inversion with N  
 
If N-values are used to construct the initial model, select Inversion with N instead of 
Inversion.  The Least Square Method dialog box settings are the same as those explained 
in Section 6.6.2.1, except that the default value for E equals 0.1 and for Regularization 
equals 0.5.   
 

6.6.3 MASW (1D) Menu: Comparison or Calculate Theoretical Dispersion 

Curves  
 
To calculate and overlay a theoretical dispersion curve over an observed dispersion 

curve, select Comparison or click the Calculate theoretical dispersion curves  button.   
The calculated curve is shown as a black line.  To remove the calculated dispersion curve 
from the display, unclick the Calculate theoretical dispersion curves button.    
 

6.6.4 MASW (1D) Menu: Show Velocity Model  
 
To toggle to the velocity model display from the dispersion curve display, select Show 

velocity model or click the Show velocity model  button.   
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6.6.5 MASW (1D) Menu: Modeling (1D) or Creating a New Velocity Model 

for Modeling  
 
A synthetic velocity model can easily be created independent of a waveform file.  
Modeling can be useful for planning a survey, modeling borehole data, or testing and 
comparing various results.  To set the parameters for a velocity model, select Modeling 

(1D) or click the Creating a new velocity model for modeling  button.   
 

 
 
Depth of model is used to indicate the maximum depth of the model.  The default 
Frequency range is suitable to simulate depth of penetration from an active source.  If the 
Depth of model is greater than 30 m or 100 ft, correspondingly, the lower end frequency 
should be set to 2 Hz to simulate a greater sampling depth.   
 
The frequency range is divided by the Number of frequency and sets the resolution of the 
dispersion curve.  The Number of frequency default value of 60 is suitable for the default 
frequency range.  If the frequency range is widened significantly, the Number of 
frequency should also be scaled up accordingly.  Upon clicking OK, the following 
homogeneous model appears; the associated dispersion curve does not yet exist.   
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To modify the velocity model, click the Correct velocity model  button. Horizontal 
black lines defining the model layers appear.  Use the mouse to click on the vertical edge 
of a layer and the selected layer edge will turn red.  Drag the edge to the desired velocity.   
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Position the rest of the layers and set the water table if desired.  
 

 
 
Refer to Section 6.6.6 to continue modeling by simulating a survey and generating a 
dispersion curve.  
 

6.6.6 MASW (1D) Menu: Calculating Waveforms, Discrete Wave-number 
Method (3D) 

 

 
 
Once a synthetic velocity model exists, to calculate the dispersion curve, first a synthetic 
waveform file must be generated.  Only active source waveform files can be simulated.  
To generate the waveform file, select Calculating waveforms, Discrete wave-number 
method (3D).  The DWM parameters dialog box settings determine how the waveform 
record is calculated.  
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The Data length is the record length in time.  Number of samples relates to the sample 
interval used in field acquisition; 1 second divided by 128 samples equals a sample 
interval of 7.8 milliseconds.  Although this is much larger than what is commonly used in 
the field for a 1D MASW survey, a value of 128 is sufficient and makes the calculation 
less computationally intensive.   
 
The Periodicity length multiplier defines the size of the calculation and the default value 
is suitable for most cases.  First receiver distance is the near offset, the Receiver spacing 
is simply the geophone interval, and the Number of receivers is the number of channels.  
Refer to Section 3.1 for values similar to what would be used in the field for a 1D 
MASW survey.  The Source depth is the depth below surface of the source; for a surface 
source enter zero.  Epsilon controls the accuracy of the calculation and the default value 
is suitable for most cases.  
 
To revert back to the default values, click Default.  
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Click OK and the corresponding waveform file is calculated and automatically displayed 
in Pickwin.    
 

 
 
The waveform file is automatically saved to the current directory with the file name 
waveform_data_DWM.8hd.   
 
Proceed with calculating phase velocity and picking the dispersion curve as if the 
synthetic waveform file was a field record.    
 

 
 
Import the dispersion curve picks into WaveEq, set-up an initial model, and run the 
inversion.  Refer to Section 6.10.7 for explanation of additional modeling functions.  
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6.7 MASW (2D) Menu 
 
The MASW (2D) menu includes functions for calculating an initial model for a 2D dataset 
and running the inversion to find the best fit of the initial model with the observed data.    
For purchases of SeisImager/SW-1D, this menu is not active.   
 

 
 
The Advanced options are not available at this time.   
 

6.7.1 MASW (2D) Menu: Show 2D Velocity Model 
 
Once initial or final models exist for a series of CMP cross-correlation gathers, the 
applicable cross-sectional model can be viewed in GeoPlot by selecting Show 2D velocity 
model.  The unit labels set in WaveEq carry over.  Refer to Section 4.1.3 for more 
information on setting display parameters in GeoPlot.   
 

6.7.2 MASW (2D) Menu: Initial Model 
 
The initial cross-sectional Vs model is the starting point for the inversion.  For 2D 
MASW, the initial cross-sectional model is interpolated from individual 1D initial models 
for a set of CMP cross-correlation gathers.  To generate an initial cross-sectional model 
from the set of gathers, select Initial model.  The Initial model for inversion dialog box 
settings are the same as those explained in Section 6.6.1 except that Apply horizontal 
interpolation is checked by default to allow the cross-sectional model to be constructed 
by interpolation between the series of 1D models. 
 

6.7.3 MASW (2D) Menu: Inversion (2D: All Data) and Inversion (with N) 
 
The Inversion (2D: All Data) and Inversion (with N) processes can be computationally 
intensive and may take some time to complete depending on the size of the dataset.  Also, 
the higher the Iteration value, the longer the process will take.  In the Windows Task 
Manager, WaveEq may report as “Not Responding”, but if the memory usage is 
dynamically changing this indicates the process is running properly. 
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6.7.3.1 MASW (2D) Menu: Inversion (2D: All Data) 
 
To calculate the Vs cross-section that best matches the observed data, select Inversion 
(2D: All Data).  The Least Square Method dialog box settings are the same as those 
explained in Section 6.6.2.1, except that the default value for E equals 0.1 and for 
Regularization equals 0.5.   
 
6.7.3.2 MASW (2D) Menu: Inversion (with N) 
 
If N-values are used to construct the initial model, select Inversion (with N) instead of 
Inversion (2D: All Data).  The Least Square Method dialog box settings are the same as 
those explained in Section 6.6.2.1, except that the default value for E equals 0.1 and for 
Regularization equals 0.5.   
 

6.7.4 MASW (2D) Menu: Calculate RMS for All Data 
 
To calculate the RMS error for an inversion, select Calculate RMS for all data.  The 
RMS error is reported as a velocity (m/s or ft/s) and a percent (%).  It is preferable for the 
error to be less than about 15%, but it will depend on the dataset.  
 

 
 

6.8 Options 
 
The Options menu includes program controls and display settings.  
 

 
 

6.8.1 Options: Dimension Size 
 
To view or change the program data input allowances, select Dimension size.  
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Present size reflects the current Maximum dispersion curves number for 2D MASW.  The 
Maximum of 2001 is the highest possible value.  To change the number, enter the new 
value, check Change dimension size, and click OK.   
 

 
 
Click OK and restart the program.  
 

 
 
The wizard automatically defaults to standard dimensions to run efficiently.  To use non-
standard dimensions, you will need to process data manually.    
 
If a program upgrade is purchased, the new registration password can be directly entered 
in the Dimension size dialog box in the Password for upgrade field; however, it is 
strongly recommended to upgrade via the SeisImager Registration program instead. 
 

6.8.2 Options: Meters and m/sec and Feet and ft/sec 
 
Select the desired unit labels by choosing meters and m/sec or feet and ft/sec.  The setting 
is reflected in the display labels, dialog box labels, and default values where applicable.  
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6.8.3 Options: Japanese 
 
The program language can be converted between English and Japanese.  To convert from 
English, check Japanese.  Obviously, this is not recommended unless you want to use the 
software in Japanese and have the necessary version of Windows.  If symbols appear in 
various places, it is likely that the language is not set to English and Windows is unable 
to render the program in Japanese. 
 

6.8.4 Options: Advanced Options: Reverse Y-Axis Text for Clipboard Copy 
 

 
 
Layered model analysis is not active at this time.  
 
Reverse Y-axis text for clipboard copy controls how the label for the vertical axis appears 
when the Edit menu, Copy to clipboard is selected.  If Reverse Y-axis text for clipboard 
copy is selected, the vertical axis label appears written top to bottom.  If not selected (the 
default), the vertical axis label appears written bottom to top.  
 

6.9 Help  
 

 
 

The Help menu or Version info  button reports the software version information.   
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6.10 Button Bar Functions  
 
The WaveEq button bar functions not already discussed in association with specific menu 
functions are explained in this section.  
 

6.10.1 Button Bar: Enlarge Waveform Amplitude  and Reduce Waveform 
Amplitude  

 
The Enlarge waveform amplitude and Reduce waveform amplitude buttons have no 
meaning in WaveEq.  
 

6.10.2 Button Bar: Reduce Horizontal Scale  and Enlarge Horizontal 

Scale  
 
To reduce or enlarge the horizontal scale of plots of dispersion curves, geometry, and 
velocity models, click the Reduce horizontal scale and Enlarge horizontal scale buttons.  
The associated keyboard shortcuts are the left arrow and right arrow keys, respectively.    
 

6.10.3 Button Bar: Enlarge Vertical Scale  and Reduce Vertical Scale  
 
To enlarge or reduce the vertical scale of plots of dispersion curves, geometry, and 
velocity models, click the Enlarge vertical scale and Reduce vertical scale buttons.  The 
associated keyboard shortcuts are the up arrow and down arrow keys, respectively.    
 

6.10.4 Button Bar: Show Previous  and Show Next  
 
To scroll through individual dispersion curves or velocity models, click the Show 
previous and Show next buttons.  In the geometry plot view, these buttons are also used to 
select a specific geometry of a waveform file to display. 
 

6.10.5 Button Bar: Home  and End  
 
To jump to the first or last of a set of dispersion curves or velocity models, click the 
Home and End buttons.   
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6.10.6 Button Bar: Calculate Theoretical Dispersion Curve by Fundamental 
Mode  

 
The Calculate theoretical dispersion curve by fundamental mode button toggles off 
Calculate theoretical dispersion curve by harmonic mode. 
 

6.10.7 Button Bar: Calculate Theoretical Dispersion Curve by Harmonic 

Mode   
 
For synthetic modeling, in the dispersion curve view, higher modes can be modeled by 
first clicking on the Calculate theoretical dispersion curve by higher mode button, then 

clicking on the Calculate theoretical dispersion curves  button.  The dispersion curve 
view will display a set of curves.  The curves with connected open circles are 
fundamental mode dispersion curves and the solid lines are the higher mode dispersion 
curves, associated with each fundamental mode curve by color.  The dashed lines are the 
relative amplitudes of the higher modes, also associated by color.   
 
 

 
 
To toggle off the higher mode dispersion curves, click the Calculate theoretical 
dispersion curves button again.  To return to the fundamental mode, click the Calculate 

theoretical dispersion curve by fundamental mode  button.  
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6.10.8 Button Bar: Select Dispersion Curve  and Correct Dispersion 

Curve  
 
The Select dispersion curve and Correct dispersion curve buttons can be used for point-

based editing.  To reverse any changes, click on the Undo  button.  
 
Click on the Select dispersion curve button then click on the point(s) on the dispersion 
curve that you wish to delete.  The selected points will be highlighted in red.     
 

 
 
When done selecting points, hit the Delete key or select the Edit menu, Delete.  If you 
change your mind and do not want to delete the selected points, click the Select 
dispersion curve button to deselect the points and exit editing mode.  
 
To edit the dispersion curve by dragging points to new positions in the direction of phase 
velocity on the plot, click the Correct dispersion curve button.  Click the left mouse 
button on the point and drag to adjust, it will turn red and then revert to white at the new 
position when the mouse button is released.  
 
The Undo button can be clicked after any deletion or repositioning to reverse the effect. 
 
 

Selected 
data points 
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7 – Basic Processing Flows  
 
The basic processing flows for 1D MASW, MAM, and 2D MASW datasets are 
summarized in this section.  In Sections 7.1, 7.2, and 7.3, the functions automatically run 
by the wizard are listed in order, with exceptions noted.  Section 7.3.1 describes the 
processing flow to individually edit 2D MASW dispersion curves in the Pickwin phase 
velocity-frequency plot view.   
 

7.1 Active Source 1D MASW 
 
1.  In Pickwin, open a waveform file. 
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2. In Pickwin, set the unit labels to meters or feet by selecting the Edit/Display menu, 
Edit source/receiver locations.  (This is not an automatic part of the wizard, but should be 
done if there is a change from the unit labels used last.) 
 

 
 
Alternatively, the unit labels may be set by selecting the Options menu, meters and m/sec 
or feet and ft/sec. 
 

 
 
3. In Pickwin, calculate phase velocity.  
 

 
 
Upon viewing the phase velocity-frequency plot, if the calculation parameters need to be 
changed, click the Undo button and re-run the process.  (This is not an automatic part of 
the wizard.)  
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4. In Pickwin, pick the dispersion curve.  
 

 
 
5. In Pickwin, import the picks into WaveEq.  
 

 
 
6. In WaveEq, edit the dispersion curve.  
 

 
 



 

SeisImager/SW Manual  7 – Basic Processing Flows 
Version 3.0, October 2009  Page 286 of 314 

7. In WaveEq, calculate the initial model. 
 

 
 
8. In WaveEq, run the inversion. 
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7.2 Passive Source MAM 
 
1. In Pickwin, make a list of the waveform files in the dataset.  
 

 
 
 



 

SeisImager/SW Manual  7 – Basic Processing Flows 
Version 3.0, October 2009  Page 288 of 314 

2. In Pickwin, set the unit labels to meters or feet by selecting the Edit/Display menu, 
Edit source/receiver locations.  (This is not an automatic part of the wizard, but should be 
done if there is a change from the unit labels used last.) 
 

 
 
Alternatively, the unit labels may be set by selecting the Options menu, meters and m/sec 
or feet and ft/sec. 
 

 
 
3. In Pickwin, run the spatial autocorrelation.  
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4. In Pickwin, calculate phase velocity. 
 

 
 
Upon viewing the phase velocity-frequency plot, if the calculation parameters need to be 
changed, click the Undo button and re-run the process.  (This is not an automatic part of 
the wizard.)  
 
5. In Pickwin, pick the dispersion curve. 
 

 
 
6. In Pickwin, import the picks into WaveEq. 
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7. In WaveEq, edit the dispersion curve. 
 

 
 
8. In WaveEq, calculate the initial model. 
 

 
 
9. In WaveEq, run the inversion.  
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7.3 Active Source 2D MASW 
 
1. In Pickwin, make a list of waveform files in the dataset. 
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2. In Pickwin, set the unit labels to meters or feet by selecting the Edit/Display menu, 
Edit source/receiver locations.  (This is not an automatic part of the wizard, but should be 
done if there is a change from the unit labels used last.) 
 

 
 
Alternatively, the unit labels may be set by selecting the Options menu, meters and m/sec 
or feet and ft/sec. 
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3. In Pickwin, save the file list for future use. 
 

 
 
4. In Pickwin, set up the source-receiver geometry.  
 

 
 
 



 

SeisImager/SW Manual  7 – Basic Processing Flows 
Version 3.0, October 2009  Page 294 of 314 

5. In Pickwin, calculate and assemble the CMP cross-correlation gathers.  
 

 
 
6. In Pickwin, calculate phase velocity for the CMP cross-correlation gathers and 
automatically pick the dispersion curves.   
 

 
 
7. In Pickwin, import the dispersion curves into WaveEq. 
 

 
 
8. In WaveEq, calculate the initial model. 
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9. In GeoPlot, view the initial model.   
 

 
 
10. In WaveEq, run the inversion. 
 

 
 
11. In GeoPlot, view the final model.   
 

 
 

7.3.1 Viewing and Editing Individual Dispersion Curves in Pickwin 
 
In Pickwin, prior to launching WaveEq, dispersion curves from a 2D MASW dataset may 
be individually edited in the phase velocity-frequency plot view.  Usually with 2D 
MASW datasets, there are too many curves to pick manually and the automatic picker is 
more precise than the human eye.  Occasionally, however, there may be a need to 
override the automatic picks.  This section describes the processing flow; these steps 
would be added in between Steps 6 and 7 in Section 7.3.   
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1. In Pickwin, click the Geometry  button to display the geometry view.  Use the 

Show previous waveform  and Show next waveform  buttons to select the CMP 
cross-correlation gather for which you want to view and edit its dispersion curve.   
 

 
 

2. Click the Waveform  button to display the waveform file for the selected CMP 
cross-correlation gather.   
 
3. Calculate phase velocity for the CMP cross-correlation gather. 
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4. The phase velocity-frequency plot for the selected CMP cross-correlation gather is 
displayed with the rest of the dispersion curves picked in Step 6 of Section 7.3.  The pink 
line connecting red picks is the individual dispersion curve associated with the selected 
CMP cross-correlation gather.  The rest of the curves are shown in green.  
 

 
 

Adjust the dispersion curve picks as desired and use the Update  button to register the 
new picks.   
 

 
 
5. To edit other dispersion curves, repeat the process from Step 1. 
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6. Once editing is complete, save the revised dispersion curves. 
 

 
 
7. Import the revised dispersion curves into WaveEq.     
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As an alternative, the saved dispersion curve file can be opened in WaveEq. 
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8 – Examples 
 

8.1 Active Source Waveform Data 
 

8.1.1 Lower Quality 
 
The shot record below lacks coherent surface wave signal from the near to far traces and 
is heavily contaminated with relatively lower frequency noise, particularly from 75 to 
170 feet.  Shot stacking or a larger source, and also waiting for a quieter recording period, 
would probably help.   
 

 
 
 
In this shot record, the takeouts for channels 6, and 12 through 16 were left open with no 
geophones connected.  No signal was recorded, giving up 100 ft of offset on the far end 
of the spread and creating a 40-foot gap in between traces 5 and 7.  
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Due to a small near offset, in this shot record, the signal on the geophone at 51 feet was 
clipped.  A few overdriven channels can be tolerated but it is best practice to not record 
clipped signal.   
 

 
 

8.1.2 Higher Quality 
 
The shot record below displays high signal-to-noise ratio, no clipped traces, and 
coherency from trace-to-trace.   
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8.2 Passive Source Waveform Data 
 

8.2.1 Lower Quality 
 
The record below shows wide variation in trace amplitude from trace-to-trace.   
 

 
 
Upon viewing the spectrum, it is clear that the frequency content is uneven.     
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A similar condition is evident in this record and associated frequency spectrum.  
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In this record, the traces are similar to each other, but over time, there is wide range in 
amplitude.    
 

 
 
The spectrum shows fairly consistent frequency content from trace-to-trace, but not as 
tight as it could be.   
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8.2.2 Higher Quality 
 
The record below is ideal showing even signal amplitude from trace-to-trace and in time.    
 

 
 
The corresponding frequency spectrum shows the energy contained in a neat envelope 
from approximately 2 to 7 Hz.  
 

 
 
 



 

SeisImager/SW Manual  8 – Examples 
Version 3.0, October 2009  Page 306 of 314 

This record has some intermittent higher-amplitude noise from passing cars (between 21 
and 26 seconds).   
 

 
 
The frequency spectrum shows the car noise has relatively little impact on the record 
quality since it comprised a relatively short period compared to the total recording time.  
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8.3 Dispersion Curves 
 

8.3.1 Characteristics  
 
Dispersion curves are smooth, curved or straight lines. 
 
  S-wave velocity structure Dispersion curve  
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Dispersion curves reflect the average velocity model beneath the geophone spread.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Dispersion curve 
changes gradually 
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Only the Rayleigh wave fundamental mode is used for analysis, although higher modes 
are present and often visible.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The frequency range within which phase velocity is considered stable corresponds to the 
minimum and maximum wavelengths recorded, and there is generally a one-to-one 
relationship between the minimum and maximum wavelength and the geophone interval 
and total offset (spread length), respectively.  
 
The bounds of the stable frequency range are depicted on the phase velocity-frequency 
plot by blue lines (shown above and by bold black lines shown below) with slopes that 
correspond to the minimum and maximum wavelengths. 
 
 

 
 

Higher mode

Noise

Fundamental 
mode

 

Fundamental mode 

Higher mode 

Dispersion curve including 
noise and higher mode 
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8.3.2 Comparison of data from ground with variable stiffness 
 

 

 
 

 

 

 
 

 

River bottom 
(soft) 

Flood plain 
(moderate) 

High 
embankment 
(hard) 
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